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PREFACE

Computers play a vital role in the modern world, and even the most basic jobs today involve technology. Therefore, 

computer education becomes essential in any student’s development. Expertise in computing enables children 

think critically, be more creative and innovative, giving space for collaborative work and individual effort.

The series of books (Class III – IX) aim to holistically develop digital skills, keeping pace with the dynamically 

changing industry requirements. 

IT education has no boundaries and irrespective of the field of work, each one is expected to have the following 

digital skills:

 MS Office (MS Word, MS Excel, MS PowerPoint)

 Photo / Image Editing

 Programming

 Website development

The enriched curriculum therefore covers a wide variety of topics across various classes: TUXPAINT; MS Word 

2007 (Level I, II & III) ; MS Excel 2007 (Level I, II & III); MS PowerPoint 2007 (Level I & II); Image / Photo editing 

software using GIMP 2.8; Scratch Programming; HTML Programming; Web creation tool using WordPress. 

The curriculum uses only open source software (freely available on the Internet) installed in Windows 7 Operating 

system.

A brief description of every concept and its application / purpose is provided in every lesson with colorful screen 

shots. This not only attracts the readers but also gives them an experience of self-learning. ‘Activity Based Learning’ 

exercises have been included as part of the curriculum. 

We hope this text book finds its place in the readers’ library for future references.
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INTRoduCTIoN 
To MS ExCELCh

ap
te

r

1
# Recap of Excel Basic concepts done in Class V

(Worksheet layout and navigation, editing cells, copying  data, worksheet operations, basic functions, 

formatting, autofill )

Basically Excel is a spread sheet program that allows storing, organizing and analyzing the data. A major strength 

of Excel is that you can perform mathematical calculations and format your data. It can be used to create reports, 

charts, automate tasks and much more.

Here is the main window of Excel 2007.  The main components of this window are.

1. WorkBook and WorkSheet 

2. Quick Access toolbar

3. Ribbon

4. Name Box

5. Formula Bar

6. Office Button

A WORKBOOK is a file created  in Excel. It is made up of many worksheets. The extension of  an Excel Work-

Book is .xlsx .  Each worksheet has its own grid full of “Cells.”  Cell is the basic unit of a work sheet. A Cell is a 

container for data and each little rectangle you see in the worksheet is a cell.  Cells are organized by columns (A, B, 

C, …) and rows (1, 2, 3, …). They can hold plain text, or calculate data with formulas (more on formulas later). 

Every cell is associated with a Cell Reference( a name given to the cell using the column name followed by the row 

number it belongs to).  Eg. B12.. This kind of reference is called Relative Reference.  

QuICK ACCESS TooLBAR

The Quick Access Toolbar lets you add commands that are always visible 

to you while working with the Workbook.  Commonly found commands 

are Save, Undo, Redo, and the New Workbook commands.

Also, if you’re looking for the “File” button, here is none. However, you 

can use the new office button as shown in the picture.

RIBBoN:  The Ribbon is the display you see at the top of the 

Microsoft Excel window. It is your primary interface with Excel. It 

allows you to access most of the commands available to you in Excel. 

The Ribbon is composed of three parts: Tabs, Groups, and Commands.
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NAME Box:  is located to the left of the formula bar.(Formula bar  is located immediately below the Ribbon). 

The Name Box displays the name (or cell reference). 

FoRMuLA BAR: This bar is located immediately above the spreadsheet labeled with function  symbol (fx). The 

formula bar comes very handy when you are dealing with a pretty long formula you want to view it entirely without 

overlaying the contents of the neighbor cells. The formula bar gets activated as soon as you type an equal sign in 

any cell or click anywhere within the bar.

NAVIgATINg WIThIN A WoRKShEET

using the mouse:

•	 Use the vertical and horizontal scroll bars if you want to move to an area of the screen that is not currently 
visible.

•	 To move to a different worksheet, just click on the tab below the worksheet.

using the keyboard:

•	 Use the arrow keys, or [PAGE UP] and [PAGE DOWN], to move to a different area of the screen.

•	 [CTRL] + [HOME} will take you to cell A1.

•	 [CTRL] + [PAGE DOWN] will take you to the next worksheet, or use [CTRL] + [PAGE UP] for the preceding 
worksheet.

•	 You can jump quickly to a specific cell by pressing [F5] and typing in the cell address. You can also type the cell 
address in the name box above column A, and press ENTER].

dATA ENTRy CELL By CELL

To enter either numbers or text:

1.  Click on the cell where you want the data to be stored, so that the cell becomes active.

2.  Type the number or text.

3.  Press [ENTER] to move to the next row, or [TAB] to move to the next column. Until you’ve pressed [ENTER] 
or [TAB], you can cancel the data entry by pressing [ESC].To enter a date, use a slash or hyphen between the 
day, month and year, for example 14/02/2009. Use a colon between hours, minutes and seconds, for example 
13:45:20. Remember that useful Undo button on the Quick Access toolbar!

dELETINg dATA

You want to delete data that’s already been entered in a worksheet? Simple!

1.  Select the cell or cells containing data to be deleted.

2.  Press the [DEL] key on your keyboard.

3.  The cells remain in the same position as before, but their contents are deleted.

MoVINg dATA

You’ve already entered some data, and want to move it to a different area on the worksheet?

•	 Select the cells you want to move (they will become highlighted).

•	 Move the cursor to the border of the highlighted cells. When the cursor changes from a white cross to a 
four-headed arrow (the move pointer), hold down the left mouse button.

•	 Drag the selected cells to a new area of the worksheet, then release the mouse button. You can also cut the 
selected data using the ribbon icon or [CTRL] + [X], then click in the top left cell of the destination area and 
paste the data with the ribbon icon or [CTRL] + [V].
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CoPyINg dATA

To copy existing cell contents to another area on the worksheet:

•	 Select the cells you want to copy (they will become highlighted).

•	 Move the cursor to the border of the highlighted cells while holding down the [CTRL] key. When the cursor 
changes from a white cross to a hollow left-pointing arrow (the copy pointer), hold down the left mouse but-
ton.

•	 Drag the selected cells to a second area of the worksheet, then release the mouse button.

You can also copy the selected data using the ribbon icon or [CTRL] + [C], then click in the top left cell of the 

destination area and paste the data with the ribbon icon or [CTRL] + [V]. To copy the contents of one cell to a 

set of adjacent cells, select the initial cell and then move the cursor over the small square in the bottom right-hand 

corner (the fill handle). The cursor will change from a white cross to a black cross. Hold down the mouse button 

and drag to a range of adjacent cells. The initial cell contents will be copied to the other cells. Note that if the 

original cell contents end with a number, then the number will be incremented in the copied cells. If the original 
cell that you are moving or copying contains a reference to a cell address, then the copied cell address will be 
adjusted relative to the target cell. 

Refer to Formulas –Referencing later in this book for details.

ACTIVITy : CREATINg ThE MARK ShEET TABLE

Step 1: To Create a MarkSheet Table with the following fields – Sno., Name, Eng, Lang, Maths, Sci, Soc. Enter 

10 records for the given table. 

Step 2: To add the following fields to the table – Total, Average, And update these new fields using appropriate 

formulae. ( Use the SUM() and AVERAGE() functions)

Step 3: Also generate the subject totals and averages, and the Max and Min marks obtained in each subject.

Step 4 : Format the column headings. Also merge and center the Table headings between the Columns A and 

Column G.

Step 5: Use Conditional Formatting and show marks that are less than 40 in red colour and 100 marks in green 

colour.

Step 6 : Apply grid lines for the tabular data of the table.

ACTIVITy  - ChART
•	 Type the data for the given table from cell A1 to cell F6. Generate 

the total population using the sum() function in the cellsB7 to F7.

•	 Format the table as shown in the picture.

•	 Select the data from A3 to F6 and click Insert tabChartColumn 
chartsStacked  
Column chart type under Illustrations. 
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 BRAIN dEVELoPER 

I. ChooSE ThE CoRRECT ANSWERS:

1. The name box

 a.  Shows the location of the previously active cell b.  Appears to the left of the formula bar

 c.  Appears below the status bar d.  Appears below the menu bar

2.  you can use the format painter multiple times before you turn it off by

 a.  You can use the format painter button only one time when you click it

 b.  Double clicking the format painter button

 c.  Pressing the Ctrl key and clicking the format painter button

 d.  Pressing the Alt key and clicking the format painter button

3.  An excel workbook is a collection of

 a.  Workbooks b.  Worksheets

 c.  Charts d.  Worksheets and charts

4.  Excel 2007 files have a default extension of

 a.  Xls b.  Xlsx

 c.  Both a. and b. d.  123

6.  If you begin typing an entry into a cell and then realize that you don’t want your entry placed into a cell, 

you:

 a.  Press the Erase key b.  Press Esc

 c.  Press the Enter button d.  Press the Edit Formula button

8.  Without using the mouse or the arrow keys, what is the fastest way of getting to cell A1 in a spreadsheet?

 a.  Press Ctrl +Home b.  Press Home

 c.  Press Shift + Home d.  Press Alt + Home

9.  It is acceptable to let long text flow into adjacent cells on a worksheet when

 a.  Data will be entered in the adjacent cells b.  No data will be entered in the adjacent cells

 c.  There is no suitable abbreviation of the text d.  There is not time to format the next

10. Which of the following methods cannot be used to edit the contents of a cell?

 a.  Press the Alt key b.  Clicking the formula bar

 c.  Pressing the F2 key d.  Double clicking the cell
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11. To copy cell contents using drag and drop press the

 a. End key  b.  Shift key        c.  Ctrl key d.  Esc key

12. Which Function is used to calculate Remainder in MS Excel?

 a.  INT (    ) b. FACT (   ) c.  MOD (   ) d.  DIV (   )

13. A spreadsheet is a collection of pages is called a _______

 a.  Workbook  b.  Art book c.  Worksheet d.  Documents

14. Where does the active cell’s contents display in Excel?

 a.  Name Box b.  Row Headings c.  Formula Bar d.  Task Pane

15. If you want a blank line after the title in the worksheet, which of these methods will be the best?

 a.  Re-Format the spreadsheet b.  Insert the Row 

 c.  Increase the column Width d.  Use the Space bar

16.Which tool you will use to join some cells and place the content at the middle  of joined cell?

 a. From Format Cells dialog box click on Merge Cells check box  

 b. From Format Cells dialog box select the Centered alignment  

 c. From Format Cells dialog box choose Merge and Center check box 

 d. Click on Merge and Center tool on formatting toolbar 

17. how can you show or hide the gridlines in Excel Worksheet?

 a.  Go to Tools >> Options >> View tab and mark or remove the check box named  Gridline        

 b. Click Border tool on Font group of Home tab                                                                        

 c.  Both of above

 d. None of above 

18. Which command will you choose to convert a column of data into row?

 a. Cut and Paste  b. Right Click >> Paste Special >> Transpose  

 c. Both of above d. None of above 

19. It is acceptable to let long text flow into adjacent cells on a worksheet when

 a.  data will be entered in the adjacent cells  

    b.  no data will be entered in the adjacent cells  

    c.  there is no suitable abbreviation for the text  

    d.  there is not time to format the text 
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20. Which of the cell pointer indicates you that you can make selection?

 a.  Doctor’s symbol (Big Plus) b.  small thin plus icon  

    c.  Mouse Pointer with anchor at the tip d.  None of above 

21. Which of the cell pointer indicates that you can fill series?

     a.  Doctor’s symbol (Big Plus) b. small thin plus icon  

     c. Mouse Pointer with anchor at the tip d. None of above 

22. What is entered by the function =today() 
 a.  The date value for the day according to system clock b. The time value according to system clock   

 c Today’s date as Text format d.  All of above

Teacher’s Signature
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ESSENTIAL LEARNINg SKILLS :
# Using Absolute Reference In A Formula

# Referencing A Cell On A Different Worksheet

# Referencing A Cell On A Different Workbook 

# Activities 1.1 to 1.5

WhAT IS A CELL REFERENCE IN ExCEL?
A cell reference or cell address is a combination of a column letter and a row 
number that identifies a cell on a worksheet.-- For example, A1 refers to the cell 
at the intersection of column A and row 1; B2 refers to the second cell in column 
B, and so on.

When used in a formula, cell references help Excel find the values the formula 
should calculate.. For instance, to pull the value of A1 to another cell, you use this 
simple formula: =A1. To add up the values in cells A1 and A2, you use this one: 
=A1+A2

WhAT IS A RANgE REFERENCE IN 
ExCEL?
In Microsoft Excel, a range is a block of two or more cells.  A 
range reference is epresented by the address of the upper left 

cell and the lower right cell separated with a colon. For example, the range A1:C2 includes 6 cells from A1 through 
C2.

hoW To CREATE A REFERENCE IN ExCEL
To make a cell reference on the same sheet, this is what you need to do:

1. Click the cell in which you want to enter the formula.

2. Type the equal sign (=).

3. Do one of the following:

•	 Type	the	reference	directly	in	the	cell	or	in	the		
 formula bar, or

•	 Click	the	cell	you	want	to	refer	to.

4. Type the rest of the formula and press the Enter key to complete it.   For example, to add up the values in cells 
A1 and A2, you type the equal sign, click A1, type the plus sign, click A2 and press Enter:  
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To CREATE A RANgE REFERENCE, SELECT A RANgE oF CELLS oN 
ThE WoRKShEET
For example, to add up the values in cells 
A1, A2 and A3, type the equal sign followed 
by the name of the SUM function and the 
opening parenthesis, Select the cells from 
A1 through A3, type the closing parenthesis, and press Enter.

RELATIVE, ABSoLuTE ANd MIxEd CELL REFERENCES:
There are three types of cell references in Excel: relative, absolute and mixed. When writing a formula for a single 
cell, you can go with any type. But if you intend to copy your formula to other cells, it is important that you use 
an appropriate address type because relative and absolute cell references behave differently when filled to other cells.

RELATIVE CELL REFERENCE IN ExCEL:
A relative reference is the one without the $ sign in the row and column coordinates, like A1 or A1:B10. By 
default, all cell addresses in Excel are relative. 

When moved or copied across multiple cells, relative references change based on the relative position of rows and 
columns. So, if you want to repeat the same calculation across several columns or rows, you need to use relative 
cell references.For example, to multiply numbers in column A by 5, you enter this formula in B2: =A2*5. When 
copied from row 2 to row 3, the formula will change to =A3*5.

ABSoLuTE CELL REFERENCE IN ExCEL
An absolute reference is the one with the dollar sign ($) in the row or column coordinates, like $A$1 or $A$1:$B$10.

An absolute cell reference remains unchanged when filling other cells with the same formula. Absolute addresses are 
especially useful when you want to perform multiple calculations with a value in a specific cell or when you need 
to copy a formula to other cells without changing references.

For example, to multiply the numbers in column A by the number 
in B2, you input the following formula in row 2, and then copy the 
formula down the column by dragging the fill handle: =A2*$B$2

*****The relative reference (A2) will change based on a relative 
position of a row where the formula is copied, while the absolute 

reference ($B$2) will always be locked on the same cell:

hoW To SWITCh BETWEEN dIFFERENT REFERENCE TyPES:
To switch from a relative reference to absolute and vice versa, you can either type or delete the $ sign manually, or 
use the F4 shortcut:

a. Double-click the cell that contains the formula.

b. Select the reference you want to change.

c. Press F4 to toggle between the four reference types.

Repeatedly hitting the F4 key switches the references in this order: A1 > $A$1 > A$1 > $A1.

hoW To CRoSS REFERENCE IN ExCEL:
To refer to cells in another worksheet or a different Excel file, you must identify not only the target cell(s), but also 
the sheet and workbook where the cells are located. This can be done by using so-called external cell reference.
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hoW To REFERENCE ANoThER ShEET IN ExCEL:
To refer to a cell or a range of cells in another worksheet, type the name of the target worksheet followed by an 
exclamation point (!) before the cell or range address.

For example, here’s how you can refer to cell A1 on Sheet2 in the same workbook:

=Sheet2!A1

If the name of the worksheet contains spaces or nonalphabetical characters, you must enclose the name within 
single quotation marks, e.g.:  =’Target sheet’!A1

To prevent possible typos and mistakes, you can get Excel to create an external reference for you automatically. 
Here’s how:

1. Start typing a formula in a cell.

2. Click the sheet tab you want to cross-reference and select the cell or range of cells.

3. Finish typing your formula and press Enter key

hoW To REFERENCE ANoThER WoRKBooK IN ExCEL:
To refer to a cell or range of cells in a different Excel file, you need to include the workbook name in square 
brackets, followed by the sheet name, exclamation point, and the cell or a range address. For example:

=[Book1.xlsx]Sheet1!A1

If the file or sheet name contains non-alphabetical characters, be sure to enclose the path in single quotation marks, 
e.g.:

=’[Target file.xlsx]Sheet1’!A1

As with a reference to another sheet, you don’t have to type the path manually. A faster way is to switch to the other 
workbook and select a cell or a range of cells there.

Activity 1.1

Prepare the T- Shirt Sales report excel sheet with daily 
total, product wise total and weekly total

a) Click  cell H4 and type - =sum(B4:G4) … to find 
total number of Extra small T-Shirts.
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b) Click H4 cell - Using the fill handle copy the formula to cells H5 to H8.

c) Click  cell B9 and type  =sum(B4:B8)…to find  total sales for Monday

d) Copy this formula to the cells C9 to G9 to find total sales for the other days of the week.

e) Also copy the formula to the cell H9 to find the Weekly Total sales for all the T-Shirts.

Activity 1.2

•	 Type	the	given	data.

•	 Merge	and	center	the	title	

•	 Center	align	the	S.No

•	 Change	the	font	color	of	Avg	Price	to	Blue	if	it	exceeds	5000

•	 Give	Comma	separator	to	numeric	values	of	columns	E	and	F	

•	 Use	Indian	Currency	symbol	for	Avg	Price

•	 Use	formulas	to	calculate	amount,	total,	average,	highest	and	lowest	sales.

•	 Copy	the	contents	of	Sheet1	to	Sheet2

•	 Rename	Sheet2	to	New	Sheet	

•	 Sort	the	contents	of	New	Sheet	in	the	ascending	order	of	AvgPrice

Solution:

•	 Click	on	cell	B1	and	drag	till	cell	F1.Click	Merge	&	Center	tool	from	Alignment	group	of		Home	tab.

•	 Select	the	S.No.	column	(from	B2	to	B14)	and	click	the	center	tool	from	Alignment	group	of		Home	tab.

•	 Select	 the	Avg	Price	 column	 (from	E2	 to	E14)	 and	 click	Conditional	 Formatting	 and	 set	 the	 appropriate	
condition. 
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•	 Select	the	datas	from	the	cells	E3	to	F14,		Click	the	comma	style	tool	from	the	Number	group	of	Home	tab.

•	 Select	the	Avg	Price	column	from	E3	to	E14	and	select	the	rupee	symbol	under	currency	category	of	Number	
tab in the Format Cells dialog Box.(to open the Format Cells dialog Box–right click in the cell, choose Format 
cell)

You can switch between two excel files by pressing ctrl+tab

Activity 1.3

Prepare the following worksheet 

a) Use absolute referencing to calculate Sales Tax.

b) Line total is to be recalculated as Unit Price * Quantity + Sales Tax

Solution:

Step 1 :  Type the above  data  from cell A2 to D13.

Step 2 :  Click	the	cell	E5	and	type		=	C5*$F$3/100	to	calculate	Sales	Tax	for	the	Item	-	10.5”	Extra	Thick 
  Dinner Plates.

Step 3 :  Copy this formula from cell E5 to cells E13.

Step 4 :  Click	cell	F5	and	type	the	formula	=C5*D5+E5	to	calculate	the	Line	total	for	10.5”	 
  Extra Thick Dinner Plates

Step 5 :  To calculate the total cost click cell F14 and type =sum(F5:F13) Format the Table according to 
  specifications.
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Activity 1.4

Prepare the following worksheet 

a)	 Calculate	total	using	auto	sum–Click	cell	F10	and	click	the	∑Auto	Sum	tool	from	the	Home	tab.

b) Calculate Tax using the tax percentage saved in sheet 2( cell F3) created in activity 4 – Click in cell F11 and 
type	the	formula	-	=F10*’Sheet	2’!F3.			

c)	 Calculate	the	grand	total	as			=F10+F11

Activity 1.5

Fill the content of cell E4 using the grand total, created in  Activity 1.4

- Type the formula -    =’Sheet 3’!F12   in cell E4 of Sheet 4.
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 BRAIN dEVELoPER 

I ChooSE ThE BEST ANSWER

1. There are three types of cell references. Relative and Mixed are two of them. __________________ is the 

third type.

2. Which cell reference will not change if copied or moved?

 a. A#2 b. &A&2 b. $A$2 c. %A%2

3. If in d3 you have  =A1, What cell does d3 refer to?

 a. D3 c. A1 b. D1 d. A3

4.  getting data from a cell located in a different cell sheet is called …

 a. Accessing b. Referencing c. Updating d. Functioning

5.  Which of the following is an absolute cell reference?

 a. !A!1 b. $A$1 c. #a#1 d. A1

6.  The cell address that we use in the formula is known as ________________.

7.  In Absolute Referencing, the relative position of rows and columns changes when you copy a formula.  

 ( TRuE oR FALSE? )

8. To use the sheet reference, which address is appropriate out of the following option?

 a. D4! Sheet1 b. Sheet! D4 c. Sheet! D4

9. Which of the following references can be used in a relative reference.

 a. $D6 b. A3 c. A$1

10. you can edit existing Excel data by pressing the

 a. F1 key b. F2 key c. F3 key  d. F4 key

11. The cell reference for a range of cells that starts in cell B1 and goes over to column g and down to row 

10 is ….

     a. G1-G10 b. B1.G10 c. B1;G10 d. B1:G10

12. A quick way to return to a specific area of a worksheet is to type in the

 a. Name box b. Formula bar c. Zoom box d. None of these
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13. NoT, ANd, oR and xoR are

 a. Logical Operators b. Arithmetic operators

 c. Relational operators d. None of the above

14. What is represented by the small, black square in the lower-right corner of an active cell or range?

 a. Copy handle b.  Fill handle c.  Insert handle d. Border

15. To calculate the remainder after a number is divided by a divisor in ExCEL we use the function?

 a. ROUND ( ) b. FACT ( ) c. MOD ( ) d. DIV ( )

Teacher’s Signature
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ESSENTIAL LEARNINg SKILLS:
# Using If Condition In A Formula

#	Using	If	With	And	&	Or

# Using Average if, Sum if And Count if Functions

# Removing Duplicate values

# Adding Comments to a cell

# Activities 2.1, 2.2

The IF function can perform a logical test and return one value for a TRUE result, and another for a FALSE result. For ex-
ample,	to	“pass”	scores	above	70:	=IF(A1>70,”Pass”,”Fail”).	More	than	one	condition	can	be	tested	by	nesting	IF	functions.	
The	IF	function	can	be	combined	with	logical	functions	like	AND	and	OR.

Purpose  : Test for a specific condition

Return value : The values you supply for TRUE or FALSE

Syntax  : =IF (logical_test, [value_if_true], [value_if_false])

Arguments :

•	 logical_test - A value or logical expression that can be evaluated as TRUE or FALSE.

•	 value_if_true - [optional] The value to return when logical_test evaluates to TRUE.

•	 value_if_false - [optional] The value to return when logical_test evaluates to FALSE.
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uSAgE NoTES:

Use the IF function to test for or evaluate certain conditions, and then react differently depending on whether the test was 
TRUE or FALSE.

In	the	example	shown	in	above,	we	want	to	assign	either	“Pass”	or	“Fail”	based	on	a	test	score.	A	passing	score	is	70	or	higher.	
The formula in D6, copied down, is:

=IF(C6>=70,”Pass”,”Fail”)

Translation: If the value in C6 is greater than or equal to 70, return “Pass”. Otherwise, return “Fail”.

The logical flow in this formula can be reversed. The formula below returns the same result:

=IF(C6<70,”Fail”,”Pass”)

Translation: If the value in C6 is less than 70, return “Fail”. Otherwise, return “Pass”.

Comparison Operators

When you are constructing a test with IF, you can use any of the following logical operators:

Comparison  
Operator Meaning Example

= equal to A1=D1

> greater than A1>D1

>= greater than or equal to A1>=D1

< less than A1<D1

<= less than or equal to A1<=D1

<> not equal to A1<>D1

IF with AND, OR (Logical Operators)

The	IF	function	can	be	combined	with	the	AND	operator	and	the	OR	operator.	For	example,	to	return	“OK”	when	A1	is	
between	7	and	10,	you	can	use	use	a	formula	like	this:

=IF(AND(A1>7,A1<10),”OK”,””)

Translation: if A1 is greater than 7 and less than 10, return “OK”. Otherwise, return nothing (“”).

To	return	B1+10	when	A1	is	“red”	or	“blue”	you	can	use	the	OR	function	like	this:

=IF(OR(A1=”RED”,A1=”BLUE”),B1+10,B1)

Translation: if A1 is red or blue, return B1+10, otherwise return B1.

Notes : To	count	things	conditionally,	use	the	COUNTIF

 To sum things conditionally, use the SUMIF 
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ExCEL CouNTIF FuNCTIoN

COUNTIF	 is	 a	 function	 to	 count	 cells	 that	meet	 a	 single	 criterion.	COUNTIF	 can	be	 used	 to	 count	 cells	with	 dates,	
numbers,	and	text	that	meet	specific	criteria.	The	COUNTIF	function	supports	logical	operators	(>,<,<>,=)	and	wildcards	
(*,?) for partial matching.

Purpose  :  Count cells that match criteria

Return value  :  A number representing cells counted.

Syntax  : 	 =COUNTIF	(range,	criteria)

ARguMENTS :

•	 Range	-	The range of cells to count.

•	 Criteria	-	The criteria that controls which cells should be counted.

uSAgE NoTES :
The	COUNTIF	function	in	Excel	counts	the	number	of	cells	in	a	range	that	match	one	supplied	condition.	Criteria	can	
include	 logical	 operators	 (>,<,<>,=)	 and	wildcards	 (*,?)	 for	partial	matching.	Criteria	 can	 also	be	based	on	 a	 value	 from	
another cell, as explained below.

Examples
In the example show, the following formulas are used:

=COUNTIF(D5:D12,”>100”)						//	count	sales	over	100
=COUNTIF(B5:B12,”jim”)								//	count	name	=	“jim”
=COUNTIF(C5:C12,”ca”)								//	count	state	=	“ca”

**Notice	COUNTIF	is	not	case-sensitive.

douBLE QuoTES (“”) IN CRITERIA
In general, text values need to be enclosed in double quotes, and numbers do not. However, when a logical operator is 
included with a number, the number and operator must be enclosed in quotes, as seen in the second example below:
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=COUNTIF(A1:A10,100)								//	count	cells	equal	to	100
=COUNTIF(A1:A10,”>32”)			//	count	cells	greater	than	32
=COUNTIF(A1:A10,”jim”)		//	count	cells	equal	to	“jim”

VALuE FRoM ANoThER CELL
A	value	from	another	cell	can	be	included	in	criteria	using	concatenation.	In	the	example	below,	COUNTIF	will	return	the	
count	of	values	in	A1:A10	that	are	less	than	the	value	in	cell	B1.	Notice	the	less	than	operator	(which	is	text)	is	enclosed	in	
quotes.

=COUNTIF(A1:A10,”<”&B1)	//	count	cells	less	than		B1

Notes
•	 COUNTIF	returns	incorrect	results	when	used	to	match	strings	longer	than	255	characters.
•	 COUNTIF	will	return	a	#VALUE	error	when	referencing	another	workbook	that	is	closed.

ExCEL SuMIF FuNCTIoN
The Excel SUMIF function returns the sum of cells that meet a single condition. Criteria can be applied to dates, numbers, 
and	text.	The	SUMIF	function	supports	logical	operators	(>,<,<>,=)	and	wildcards	(*,?)	for	partial	matching.
Purpose : Sum numbers in a range that meet supplied criteria

Return value  : The sum of values supplied.

Syntax  :  =SUMIF (range, criteria, [sum_range])

ARguMENTS : 
Range - The range of cells that you want to apply the criteria against.
Criteria - The criteria used to determine which cells to add.
Sum_Range - [optional] The cells to add together. If sum_range is omitted, the cells in range are added together instead.
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uSAgE NoTES 

The SUMIF function returns the sum of cells in a range that meet a single condition. The first argument is the range to apply 
criteria to, the second argument is the actual criteria, and the last argument is the range containing values to sum. SUMIF 
supports	logical	operators	(>,<,<>,=)	and	wildcards	(*,?)	for	partial	matching.	If	you	need	to	apply	more	than	one	criteria,	use	
the SUMIFS function.

Example #1 - Basic Usage

In the worksheet shown, there are three SUMIF examples. In the first example (G6), SUMIF is configured to sum values 
greater	than	100.	In	the	second	example	(G7),	SUMIF	returns	the	sum	of	values	where	the	Rep	is	“Jim”.	In	the	last	example	
(G8),	SUMIF	is	configured	to	sum	values	where	the	state	is	“CA”	(California).

=SUMIF(D6:D10,”>100”)	//	values	>	100
=SUMIF(B6:B10,”Jim”,D6:D10)	//	Rep	=	Jim
=SUMIF(C6:C10,”ca”,D6:D10)	//	State	=	CA

Notice	the	equals	sign	(=)	is	not	required	when	constructing	“is	equal	to”	criteria.	Also	notice	SUMIF	is	not	case-sensitive.		
You	can	sum	values	where	the	Rep	is	Jim	using	“jim”	or	“Jim”.

Example #2 - criteria from another cell

A value from another cell can be included in criteria using concatenation. In the example below, SUMIF will return the sum 
all	sales	over	the	value	in	G4.		Notice	the	greater	than	operator	(>),	which	is	text,	must	be	enclosed	in	quotes.	The	formula	
in G5 is:

=SUMIF(D5:D9,”>”&G4) // sum if greater than G4

Example #3 – SUMIF - not equal to

To	express	“not	equal	to”	criteria,	use	the	“<>”	operator	surrounded	by	double	quotes	

=SUMIF(B5:B9,”<>red”,C5:C9)	//	not	equal	to	“red”

=SUMIF(B5:B9,”<>blue”,C5:C9)	//	not	equal	to	“blue”

=SUMIF(B5:B9,”<>”&E7,C5:C9)	//	not	equal	to	E7
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Again notice SUMIF is not case-sensitive.

Example #4 - SUMIF with dates

The best way to use SUMIF with dates is to refer to a valid date in another cell, or use the DATE function. The example 
below shows both methods:
=SUMIF(B5:B9,”<”&DATE(2019,3,1),C5:C9)
=SUMIF(B5:B9,”>=”&DATE(2019,4,1),C5:C9)
=SUMIF(B5:B9,”>”&E9,C5:C9)

Notice we must concatenate an operator to the date in E9.

ExCEL AVERAgEIF FuNCTIoN
The	Excel	AVERAGEIF	function	computes	the	average	of	the	numbers	in	a	range	that	meet	the	supplied	criteria.	The	criteria	
for	AVERAGEIF	supports	logical	operators	(>,<,<>,=)	and	wildcards	(*,?)	for	partial	matching.

Purpose  :  Get the average of numbers that meet criteria

Return value  :  A number representing the average.

Syntax :			=AVERAGEIF	(range,	criteria,	[average_range])

ARguMENTS 
•	 range - One or more cells, including numbers or names, arrays, or references.

•	 criteria - A number, expression, cell reference, or text.

•	 average_range - [optional] The cells to average. When omitted, range is used.

uSAgE NoTES 
AVERAGEIF	 computes	 the	 average	 of	 the	 numbers	 in	 a range that meet the supplied criteria. If average_range is not 
supplied, the cells in range are averaged. If average_range is supplied, cells in average_range that correspond to cells in range 
are averaged. To determine which cells are averaged, criteria is applied to range. Criteria can be supplied as numbers, strings, 
or references. For example, valid criteria	could	be	10,			“10”	“>10”,	or	A1.
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NOTES: Cells in range that contain TRUE or FALSE are ignored.

•	 Empty	cells	are	ignored	in	range and average_range when calculating averages.

•	 AVERAGEIF	returns	#DIV/0!	if	no	cells	in	range	meet	criteria.

•	 Average_range does not have to be the same size as range. The top left cell in average_range is used as the starting point, 
and cells that correspond to cells in range are averaged.

Activity 2.1 – (Using IF condition in a Formula)

a. Enter the age of a person in cell A2. Display if he/she is 
eligible to vote in cell B2 using IF

Step 1 :  Click on cell A2

Step 2 :  Enter the age of a person

Step 3 :  Click on cell B2 

Step 4  :		 Enter	=if(A2>=18,”Eligible	to	vote”,	“Not	
Eligible”)

b. Enter the points scored by 5 people and display the badge they are eligible to receive. A person gets a GREEN badge if 
the points scored are above 80 otherwise gets a BLUE badge.Also calculate the number of blue and green badges (using 
COUNTIF)

Step1 : Click on B3 and enter Points 

Step2  : Click on C3 and enter Badge

Step 3 :  Enter the values as shown above  in cells  to  B8

Step 4 :		 Click	on	C4	and	enter	=IF(B4>80,”GREEN”,”BLUE”)

Step 5 :  Click and drag till C8 to get the badge colours for other cells.

Step 6 :		 Click	on	cell	B10	and	enter	Blue	Badges

Step 7 :  Click on cell B11 and enter Green Badges

Step 8 :		 Click	on	cell	C10	and	enter	=COUNTIF(C4:C8,”BLUE”)	

Step 9 :		 Click	on	cell	C11	and	enter	=COUNTIF(C4:C8,”GREEN”)

B C
3 Points Badge
4 56 BLUE
5 92 GREEN
6 87 GREEN
7 67 BLUE
8 52 BLUE
9
10 Blue Badges 3
11 Green Badges 2
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c. Enter the age of 5 people. Calculate discount in train ticket of 8% for minors and senior citizens and 5% for the rest.

Step 1 :  Click on B2 and enter Age 

Step 2 :  Click on C2 and enter Amount

Step 3 :  Click on D2 and enter Discount

Step 4 :		 Enter	the	values	87,25,56,15,34	in	cells	B3	to	B7

Step 5 :		 Enter	the	values	580,450,200,560	and	180	in	cells	C3	to	C7

Step 6 :  Click on cell D2 and enter   Discount

Step 7 : 	 Click	on	cell	D3	and	enter	=IF(B3>=18,8,5)	and	press	Enter	Key.

Step 8 :		 Drag	till	cells	D7	to	get	discount	for	other	cells

Step 9 :  Click on cell E2 and enter Discount amount

Step10 : 	 Click	on	cell	E3	and	enter	=C3*D3/100	and	press	Enter	key

Step 11 : 	 Drag	till	cells	E7	to	get	discount	for	other	cells

d. Enter ten number values (positive and negative). Calculate and display the total of only positive numbers. Calculate and 
display the average of all negative numbers.

Step 1 : 	 Enter	numbers	1	to	10	in	cells	B4	to	B13

Step 2 : 	 Enter	10	numbers	(	positive	and	negative		numbers)	in	cells	C4	to	C13	

Step 3 : 	 Click	on	cell	C14	and	enter	=	Sumif(C4..C13,	“>0”)

Step 4  : 	 Click	on	cell	C15	and	enter	=Averageif(C4..C13,	“<0”)

e. Prepare the below worksheet of 5 students to find the eligibility for rank

Step 1 :  Enter the row header as Student sub1 sub2 sub3 sub4 sub5 Eligible for rank in cells   B2 to H2

Step 2 : 	 Enter	student	details	in	cells	B3	to	G7

Step 3 :  Click	on	H3	and	enter	=IF(AND(C3>40,D3>40,E3>40,F3>40,G3>40),”Yes”,”No”)
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Step 4 :		 Click	and	drag	till	H7	to	get	eligibility	for	all	students.

Activity 2.2 (Removing duplicate values)

a) Enter few numbers with repetition in column B. Copy the values to Column D and remove the duplicate values.

Step 1 : Enter some numbers with repetition in cells B4 to B18 with heading Actual values

Step 2 : Click on Cell D3 and enter Unique values

Step 3 : Copy the numbers from cells B4 to B18 and paste it in cells D4 to D18

Step 4 : Click on Data tab and select Remove duplicates

The values after removing the duplicates will be as below:

b)	Enter	50	names	in	a	worksheet	and	remove	the	duplicate	values.	(Based	on	the	steps	in	activity	2.2	a)	try	to	
remove the duplicate values)

c)	Enter	comments	as	below	RED-	ShivajiHouse	,	BLUE	–	Tagore	House,	GREEN	–	Bharathi	House	,	YELLOW	
– Pratap House.
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Step 1 : 	 Click	on	cell	C1	and	enter	ROLLNO

Step 2 :  Click on cell D1 and enter COLOUR

Step 3 :  Click on cell C2 and enter 8345, Click on cell C4 and enter 8152, Click on cell C6 and enter 8215 
  and Click on cell C6 and enter 8438

Step 4 :		 Enter	the	colours	RED,	BLUE,	GREEN	and	YELLOW	in	cells	D2,	D4,	D6	and	D8	respectively.

Step 5 : 	 Click	 on	 cell	D2	 click	 Review	Tab	 and	 select	New	Comment	 and	 type	 SHIVAJI	HOUSE	 in	 the 
  comment box

Step 6 :  Repeat step 5 to enter comments for other colours
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 BRAIN dEVELoPER 

1. Which function in Excel checks whether a condition is true or not ?

 a. SUM b. COUNT c. IF d. AVERAGE

2. Which of the following is a comparison operator for inserting a not equal to argument in an IF, CouN-

TIF or SuMIF function?

 a. <= b. <>  c. >=  d. ><

3.  Study the screenshot on the right.  Which of the following functions, when inserted in the highlighted 

cell (C2) above, will return the word “yes” ?

 a.  =IF(B2>50,”yes”) b.  =IF(C2=”yes”) c.  =IF(B2=C2, “yes”) d.  =IF(B2=50, “yes”)

4. Which of the following represent the correct arguments for the SuMIF function?

 a. =SUMIF(criteria, range, criteria_range) b.  =SUMIF(criteria_range, true, false)

 c. =SUMIF(range, criteria, [sum_range]) d.  =SUMIF(range, sum_range, [criteria])

5.  Which of the following is the correct formula syntax for using the CouNTIF function?

 a. =COUNTIF(criteria, range) b.  =COUNTIF(criteria, range, [count_range])

 c. =COUNT(IF(range, criteria)) d.  =COUNTIF(range, criteria)

6. The ________________ function finds average for the cells specified by a given set of conditions or 

criteria.

 a.  =averageif(   ) b.  =sumif(  ) c.  =countif(    ) d.  =if(    )

7.  The function used for adding the cells specified by a given set of condition or criteria

 a.  =averageif(    ) b.  =sumif(    ) c.  =countif(    ) d.  =if(    )  

8. The function used to count the entries in a range based on a criteria.

 a.  =averageif() b.  =sumif() c.  =countif() d.  =if()

9.    >, <, =, >=, <=, <> are 

 a.  Logical Operators b.  Comparison Operators

 c.  Arithmetic Operators
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10.    And, or, Not are

 a.  Logical Operators b.  Comparison Operators

 c.  Arithmetic Operators

11. +, -, *, / are

 a.  Logical Operators b. Comparison Operators

 c.  Arithmetic Operators

12. =ANd(A2>A3, A2<A4)

       Determines if the value in cell A2 is ____ the value in A3____ also if the value in A2 is ___the value in A4.

        ( Fill in the blanks with the following – greater than, less than, And, Or)

13. =Not(A2+A3=24)

 a.  Determines if the sum of the values in the cells A2 and A3 is not equal to 24.

 b.  Determines if the sum of the values in the cells A2 and A3 is equal to 24.

 c.  Determines if A2+A3 is equal to 24

 d.  Both a. and c.

Teacher’s Signature
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ESSENTIAL LEARNINg SKILLS
#What..If Analysis - Pivot Tables, goal seek, defining Scenarios

#Resizing, Rotating And Cropping An Image

#grouping And ungrouping objects  

Activities: - 3.1, 3.2, 3.3, 3.4, 3.5, 3.6

By using What-If Analysis tools in Excel, you can use several different sets of values in one or more formulas to 

explore all the various results.

For example, you can do What-If Analysis to build two budgets that each assumes a certain level of revenue. Or, 

you can specify a result that you want a formula to produce, and then determine what sets of values will produce 

that result. Excel provides several different tools to help you perform the type of analysis that fits your needs.

Three kinds of What-If Analysis tools come with Excel:- Scenarios, Goal Seek, and Data(Pivot) Tables. Scenarios 

and Data tables take sets of input values and determine possible results. 

ExCEL PIVoT TABLES

Pivot table is a reporting engine built into Excel. They are the single best tool in Excel for analyzing data without 

formulas. You can create a basic pivot table in about one minute, and begin interactively exploring your data. 

With very little effort (and no formulas) you can look at the same data from many different perspectives. You can 

group data into categories, break down data into years and months, filter data to include or exclude categories, and 

even build charts.

The beauty of pivot tables is they allow you to interactively explore your data in different ways.

INSERT PIVoT TABLE

1. Use the given Sample sales data to create this Pivot Table. 

To start off, select any cell in the data and click Pivot 

Table on the Insert tab of the ribbon: Excel will display 

the Create Pivot Table window. Notice the data range 

is already filled in. The default location for a new pivot 

table is New Worksheet.

2. Override the default location and enter H4 to place the 

pivot table on the current  worksheet:

3.  Click OK, and Excel builds an empty pivot table starting 

in cell H4.

WhAT…IF ANALySIS
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4. Excel also displays the PivotTable Fields pane, which is 

empty at this point. Note all five fields are listed, but 

unused.

5. To build a pivot table, drag fields into one the Columns, 

Rows, or Values area. The Filters area is used to apply 

global filters to a pivot table.

6. The pivot table below shows total sales by product, but 

you can easily rearrange fields to show total sales by 

region, by category, by month, and so on.

NOTE: Source data should have no blank rows or columns, and no subtotals. Each column should have a unique 

name (on one row only) and represent a field for each row/record in the data:

uSE A PIVoT TABLE To CouNT ThINgS

By default, a Pivot Table will count any text field. This can be a really handy feature in a lot of general business 

situations. For example, suppose you have a list of employees and want to get a count by department? To get a 

breakdown by department, follow these steps:

a. Create a pivot table normally

b. Add the Department as a Row Label         

c. Add the employee Name field as a Value

d. The pivot table will display a count of employee by Department
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Employee breakdown by department

ShoW ToTALS AS A PERCENTAgE

In many pivot tables, you’ll want to show a percentage rather than a count. For example, perhaps you want to show 

a breakdown of sales by product. But, rather than show the total sales for each product, you want to show sales as 

a percentage of the total sales. Assuming you have a field called Sales in your data, just follow these steps:

a. Add Product to the pivot table as a Row Label

b. Add Sales to the pivot table as a Value

c. Right-click the Sales field, and set “Show Values As” to “% of Grand Total”

See the tip below “Add a field more than once to a pivot table” to learn how to show total sales and sales as a percent 

of total at the same time. 

Changing value display to % of total
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Sum of employees displayed as % of total

goAL SEEK
If you know the result you want from a formula, use Goal Seek in Excel to find the input value that produces this 

formula result.  Goal Seek requires a single input cell and a single output (formula) cell.

goAL SEEK ExAMPLE 1
Use Goal Seek in Excel to find the grade on the fourth exam that produces a final grade of 70.

1. The formula in cell B7 calculates the final grade.

3. On the Data tab, in the Data tools group, click 

What-If Analysis.

4. Click Goal Seek. The Goal Seek dialog box appears.

5. Select cell B7.

6. Click in the ‘To value’ box and type 70.

7. Click in the ‘By changing cell’ box and select cell 

B5.

8. Click OK.

Try it & You will notice that a grade of 90 on the fourth exam produces a final grade of 70.

To retain the leading zeros in a number,  
begin the entry with an apostrophe
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Activity 3.1

Bond Election
Option Votes Percentage
YES 4478 63.90
NO 2530 36.10
Total 7008

a) To win the election the percentage of YES votes has to be 70.

b) Change the percentage of  YES votes to 70 and accordingly the votes has to be changed automatically using 

Goal Seek. The final output should be as below:

Solution:

Step 1 : Type the above data from A1 to D5

Step 2 :  Click What-if Analysis Goal Seek tool from Data tab

Step 3 : 	 Type	D3	in	the	Set	cell	box	and	70	in	the	To	value	box	and	c3	in	the	By	changing	cell	

Step 4 : 	 Click	OK	-	the	number	of	votes	is	required	to	get	70%		in	cell	D3	appears		in	cell	C3.

Activity 3.2:

MARK SHEET FOR 2017-18
R.NO. NAME ENG LANG MATH SCI SOC TOT AVG
1 ADITI 74 65 66 71 89 365 73
2 AKSHAYA	ANAND 78 65 44 67 78 356 66.4
3 ANUSHREE 80 78 67 55 76 369 71.2
4 ARSHANA 49 67 80 86 87 420 73.8
5 ARUTHRA 98 78 87 67 90 393 84
6 DIVYA 65 76 87 76 89 404 78.6
7 KANISHKA 76 78 84 90 76 397 80.8
8 KEERTHANA 78 85 67 78 89 397 79.4
9 KEERTHIGAMBIGAI 89 87 78 87 56 397 79.4
10 KRITI 91 97 96 99 98 481 96.2
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Using	Goal	Seek	Set	the	total	of		students	of		Roll	no	1	and	2	to	375	by	changing	the	maths	marks.

RoLL No 1
Step 1 :  Type the above data/formulae from A1 to I12

Step 2 : Click What-if Analysis  Goal Seek tool from the Data tab

Step 3 :		 Type	H3	in	the	Set	cell	box	and	375	in	the	To	value	box	and	E3	in	the	By	changing	cell	box

Step 4 :		 Click	OK	-	the	MATH	mark	that		is	required	to	get	a	375	total		in	cell	H3	appears	in	cell	E3.

NOTE: 	Similarly	repeat	the	above	steps	for	ROLL	NO	2.	(Math	mark	for	Roll	no	2	is	in	cell	E4

SCENARIo MANAgER
What-If Analysis in Excel allows you to try 
out different values (scenarios) for formulas. 
The following example helps you master 
what-if analysis quickly and easily.

Assume	you	own	a	book	store	and	have	100	
books	in	storage.	You	sell	a	certain	%	for	the	
highest	price	of	50/-	and	a	certain	%	for	the	
lower	price	of	20/-.

If		you	sell	60%	for	the	highest	price,	cell	D10	calculates	a	total	profit	of	60	*	Rs.50	+	40	*	Rs.20	=	Rs.3800.

CREATE dIFFERENT SCENARIoS
But	what	if	you	sell	70%	for	the	highest	price?	And	what	if	you	sell	80%	
for	the	highest	price?	Or	90%,	or	even	100%?	Each	different	percentage	
is a different scenario. You can use the Scenario Manager to create these 
scenarios.

Note: You can simply type in a different percentage into cell C4 to see the 
corresponding	result	of	a	scenario	in	cell	D10.	However,	what-if	analysis	
enables you to easily compare the results of different scenarios.

1. On the Data tab, in the 
Data Tools group, click 
What-If Analysis.

2. Click Scenario Manager.

The Scenario Manager dialog box appears.

3. Add a scenario by clicking on Add.

4.	Type	a	name	(60%	highest),	select	cell	C4	(%	sold	for	the	highest	
price)	for	the	Changing		cells	and	click	on	OK.

5.	Next,	add	4	other	scenarios	(70%,	80%,	90%	and	100%).	

Finally, your Scenario Manager should be consistent with the 
picture below:
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SCENARIo SuMMARy
To easily compare the results of these scenarios, execute the following 

steps.

1. Click the Summary button in the Scenario Manager.

2. Next, select cell D10 (total profit) for the result cell and click on 

OK.

Result:

Conclusion: if you sell 70% for the highest price, you obtain a total 

profit of Rs.4100, if you sell 80% for the highest price, you obtain a 

total profit of Rs.4400, etc. That’s how easy what-if analysis in Excel 

can be.

Activity 3.3
Prepare the statement as below. Use Scenario manager and create changes and also show the scenario summary.

BudgET PLAN
RENT 500
FOOD 300
TRANSPORTATION 80
OTHER EXP 100
MONTHLY INCOME 1500
OTHER INCOME 0
TOTAL INCOME 1500
TOTAL EXPENSES 980
SAVINGS 520

Change Food to 400, Transportation to 120, monthly income to 2000 for Scenario named modify 1 and Change 

Food to 400, Transportation to 120, monthly income to 1500 for Scenario named modify 2.

Step 1 :  Type the above data/formulae (Budget Plan) from A1 to B14

Step 2 :  Click What-if Analysis Scenario Manager tool from the Data tab and Click the Add button
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Step 3 :  Type the Scenario name as Current Values and  type $B$3:$B$9 in the Changing cells box and click 

OK button.  

Step 4 :  Check and change the values of  the cells (if  required) that need to be changed for the given scenario 

and click Add button.

Step 5:  Repeat the Step 3 and 4 for Scenario called modify 1 and Scenario called modify 2.

Step 6:  Click the Summary button - A Scenario Summary sheet is added to the workbook.

Activity 3.4

Change the picture shape and border. Change the picture border weight to 3pts and dashes too.

Step 1:  Select the picture.

Step 2: Click Picture tools tab

Step 3:  Click Picture Shape tool from the Picture Styles 

group.

Step 4: Select the Basic ShapesClick TearDrop 

Step 5:  Click Picture Border and set weight to 3 pts and 

select a Dashed line from Dashes.

Activity 3.5   -  Resize and Crop the picture as below

Step 1: Select the picture and click Picture Tools tab on 

top of window.

Step 2: Repeat the steps given for Activity 3.4

Activity 3.6

Insert a picture in excel. Place a textbox and group them together as below. 

Step 1:  Click Insert tab.

Step 2:  Choose TextBox tool from Text group of  Insert tab

Step 3:  Click and drag a rectangle on the Picture and type 

tulips in it.

Step 4:  Click the border of this Text Box and  keeping the 

Ctrl key pressed, click the  picture (to Select both the Text 

and the picture simultaneously )

Step 5:  Click the Format tabclick Group tool from 

Arrange group.
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 BRAIN dEVELoPER 

1. The arrangement of arguments in a function 

 a. Structure b.  Grammar c.  Syntax

2. A logical function that returns true if any of the conditions are true.

 a. AND  b. NOT c. OR

3. A ________________________ is an interactive Excel report that summarizes and analyzes large amounts 

of data.

4. The _______________________________ an area to position fields by which you want to filter the 

PivotTable report.

5. The __________________________ is an area to position fields that contain data that is summarized in 

a PivotTable.

6. The __________________________ is the upper portion of the PivotTable Fields pane containing the 

column titles from your source data.

7. ____________________________ is a logical function that counts the cells that meet specific criteria in 

a specified range.

8. _______________________ is a  what-if analysis tool that compares alternatives.

9. ______________ function  contains one logic test—it will add values in a specified range that meet 

certain conditions or criteria.

10.  The __________________ logical function takes only one argument and is used to 

test one condition. If the condition is true, the function returns the logical opposite false. If the condition 

is false, true is returned.

11. ________________is a what-if analysis tool that finds the input needed in one cell to 

arrive at the desired result in another cell.
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12. under which tab and in which function group will you find the option to insert a Pivot Table?

 a. Under the Insert tab in the Tables group

 b. Under the Formulas tab in the Data Analysis group

 c. In the Data group in the Pivot Tables group

 d. In the Data group in the Tables group

13. Which of the following is NoT a box in the PivotTable Fields List?

 a. Column Labels    b. Values   c.  Report Filter    d.  Formula

14. What function displays row data in a column or column data in a row?

 a. Hyperlink b. Transpose c.  Index    d. Rows

15. Which of the following tool you will use in Excel to see what must be the value of a cell to get required 

result?

 a. Formula Auditing    b. Research   c. Track Change   d. Goal Seek 

16. To apply goal Seek command your cell pointer must be in

 a) The Changing cell whose value you need to find 

 b) The Result Cell where formula is entered 

 c) The cell where your targeted value is entered   

 d) None of above 

17. Which of the following is not What IF analysis tool in Excel?

 a. Goal Seek      b. Scenarios      c. Macros       d. None of above

Teacher’s Signature
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PRoTECTINg WoRKShEET
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ESSENTIAL LEARNINg SKILLS:

# Protecting The Worksheet

# Protecting a workbook from being opened and modified

# More Activities

uSE CELL PRoTECTIoN To PREVENT EdITINg AN AREA oF ThE 
SPREAdShEET:

If you share a workbook with other users, it’s important to prevent accidental edits. There are multiple ways you 

can protect a sheet, but if you just want to protect a group of cells, here is how you do it. First, you need to turn on 

Protect Sheet. Click the Review Tab, then click Protect Sheet. Choose the type of modifications you want to prevent 

other users from making. Enter your password, click OK then click OK to confirm.

PRoTECT A WoRKShEET:

Excel 2007 includes a Protect Workbook command that prevents others from making changes to the layout of the 

worksheets in a workbook. You can assign a password when you protect a workbook so that only those who know 

the password can unprotect the workbook 

and make changes to the structure and layout of the worksheets.

Activity 4.1

a) Open the file created in activity 14. Protect the worksheet by giving a password. Close the file. Open the file 

again and make changes

Step 1:  On the Review tab, in the Changes group, click Protect Sheet.

Step 2:  In the Allow all users of this worksheet to list, select the elements that you want users to be able to 

change.

Step 3:  In the Password to unprotect sheet box, type a password for the sheet, click OK, and then retype the 

password to confirm it.

This will protect the worksheet not allowing users to insert or delete rows & Columns

b) Protect the workbook with a password to open.

1. Click the Microsoft Office Button , and then click Save As. 

2. Click Tools, and then click General Options. 
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3. Do one or both of the following: 

a. If you want reviewers to enter a password before they can view the workbook, type a password in the Password 

to open box. 

b. If you want reviewers to enter a password before they can save changes to the workbook, type a password in the 

Password to modify box.

uNPRoTECTINg A WoRKBooK

a. Click the Unprotect Workbook command button in the Changes group on the  Review tab.

b.  If you assigned a password when protecting the workbook, type the password in the Password text box and click 

OK.

MoRE ACTIVITIES

a) Prepare the consolidated mark statement of students (minimum 100 students) with columns as below

SNO NAME DEPT SEC TERM1 TERM2 AVG RESULT RANK

•	Use	Sum	function	to	find	the	total	of	TERM1	and	TERM2

•	Calculate	AVG		as	(Term1	+	Term2)/2
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•	Result	is	displayed	as	PASS	if	marks	scored	in	Term1	and	Term2	is	above	50%.	Else	Result	is	displayed	as	FAIL.

•	Calculate	Rank	for	students	whose	result	is	PASS

b) Copy the worksheet data of first 10 students to Sheet2 and prepare a chart to show their performance.

c) Copy the worksheet data of first 20 students to Sheet 3 and sort them in ascending order of Rank

d) Copy the worksheet data of last 30 students to Sheet4 and display the number of students with PASS result. 

Also display the Pass Percentage.

e) For the students in Sheet4 use Conditional formatting and change font color for different Departments as below

ME – Red ,  EE – Blue  ,  CE -  Green , CHE – Yellow

f ) Add Comments to at least 5 cells in Sheet2

g) Copy the contents of Sheet3 to Sheet 5 and perform GoalSeek analysis.

h) Copy the last 10 contents of  Sheet 4 to Sheet 6 and perform scenario analysis for at least 2 situations with 

minimum 5 changes.

g) Protect the worksheet by giving it a password.
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 BRAIN dEVELoPER 

1. In order for the Lock or unlock Cells function to work, which option should be enabled? 

 a.  The Protect Workbook function needs to be enabled.

 b.  No functions need to be enabled other than the lock or unlock cells options.

 c. The worksheet must be saved before the cells will become locked or unlocked.

 d.  The Protect Worksheet function needs to be enabled.

2. What is the only way of removing password encryption on an Excel file?

 a.  Resaving the workbook as a new document or making a copy of it.

 b.  Opening the workbook as Read Only and resaving it without a password.

 c.  Opening the workbook in Protected View and resaving it without a password.

 d.  Entering the password to open the Workbook and then deleting the password created in the  

  Permissions – Encrypt with Password box.

3. To protect a worksheet, you can choose Protection and the Protect Sheet from the ….. Tab

 a.  Home                 b.  Data           c.  Review                       d.  Tools

Teacher’s Signature
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Term - II
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Introduction to gimp
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LEARNINg oBjECTIVES

•	 Introduction	to	GIMP	software.

•	 Features	of	GIMP.

•	 How	to	load	GIMP.

•	 Parts	of	the	GIMP	Window	and	Tool	box.

•	 Creating	a	new	file.

•	 Selection	tools.

INTRoduCTIoN

GIMP (GNU Image Manipulation Program) is an image retouching and editing tool. It is free and open-source 

software. GIMP has tools used for image retouching and editing, free-form drawing, creating graphics and logos, 

resizing and cropping photos, altering  colors, combining multiple images, removing unwanted image features, 

and converting between different image formats. It is similar to Adobe Photoshop, which is very popular with the 

image editing industry.

The GIMP user interface is now available in two modes:

•	 Multi-window	mode

•	 Single	window	mode

When you open GIMP for the first time, it opens in multi-window mode by default. You can enable single-win-

dow mode through WindowsSingle-Window Mode. In single-window mode, GIMP will put dockable dialogs 

and images in a single, tabbed image window.  After quitting GIMP with this option enabled, GIMP will start in 

single-window mode next time.

1.  FEATuRES oF gIMP

•	 It	can	be	used	as	a	simple	paint	program

•	 An	expert	quality	photo	retouching	program.	

•	 It	supports	layers	and	channels	so	that	you	can	apply	very	minute	effects.	

•	 It	has	advanced	selection	tools	that	allow	you	to	select	and	manipulate	very	fine	areas	of	the	image.	

•	 A	mass	production	image	renderer.	

•	 The	 advanced	 scripting	 interface	 allows	 everything	 from	 the	 simplest	 task	 to	 the	 most	 complex	 image	

manipulation procedures to be easily scripted. 
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•	 GIMP’s	native	file	 format	 is	 ‘XCF’.	 (XCF,	 short	 for	 eXperimental	Computing	Facility,	 is	 the	native	 image	

format of the GIMP image-editing program. It saves all of the data the program handles related to the image, 

including, among others, each layer, the current selection, channels, transparency, paths and guides)

•	 It	can	convert	and	save	files	to	many	file	formats	such	as	gif,	jpeg,	png,	bmp,	tiff	etc.

•	 Virtually	unlimited	images	can	be	opened	at	one	time.	

•	 GIMP	works	with	numerous	operating	systems	including	Linux,	Mac	OS	and	Microsoft	Windows.	

2. To LoAd gIMP 2.8 FoLLoW ThE STEPS gIVEN BELoW 

Select Start  All Programs  GIMP 2.8  

(or)  

Click on the  icon on the desktop.

3. PARTS oF ThE gIMP WINdoW
 

Title bar 
Menu bar 

Image window 

Tool box 

Quick Mask 
Toggle 

Units 
menu 

Zoom 
button 

Image Window 
Resize Toggle 

Navigation 
control 

Ruler 

Menu 
button 

Pointer Co-
ordinates 

The screenshot above shows the most basic arrangement of GIMP windows that can be used effectively. Three 

windows are shown:

The Main Tool box: This is the heart of the GIMP. It contains the highest level menu, plus a set of icon buttons 

that can be used to select tools, and more. 
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Tool options:  Docked below the main Toolbox is a Tool Options dialog, showing options for the currently select-

ed tool (in this case, the Rectangle Select tool). 

An image window: Each image open in GIMP is displayed in a separate window. 

Layers dialog: This dialog window shows the layer structure of the currently active image, and allows it to be 

manipulated in a variety of ways. The Layers dialog comes into play whenever you work with an image that has 

multiple layers.

Brush/Patterns/gradients: The docked dialog below the layer dialog shows the dialogs for managing brushes, 

patterns and gradients. This is a minimal setup. There are over a dozen other types of dialogs used by GIMP for 

various purposes, but users typically create them when they are needed and close them when they are not.

4. gIMP TERMINoLogy

•	 Image – An image is the fundamental component that a user uses while working with GIMP. 

•	 Layers – A GIMP image does not consist of just one image. It has many layers, which put together, constitute 

the image. You can imagine a GIMP image to be a book with many pages each containing an element of the image, 

instead of just a single sheet with the entire image on it.

•	 Selection – You can select a part of an image so that the command you use or the effect you choose will be 

performed on that selection. This is a very important concept because often, you will want to modify or apply a 

special effect on a part of the picture. So GIMP has advanced selection options because how you select an image 

affects the way the effect is applied on it.

5. TooL Box

GIMP has a “Toolbox” to quickly perform basic tasks. Toolbox is customizable, this means that you can add / 

remove any tool you want.
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Now we will discuss about the Brush tool in the Tool box.
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PAINT BRuSh TooL:

The GIMP contains many brush tools. The paint brush tool paints fuzzy brush strokes. All strokes are rendered 

using the current brush.

ACTIVATE PAINT BRuSh TooL:

You can activate the Paintbrush Tool in any one of the following order: 

•	 Tools	menu	->Paint	Tools	->Paintbrush	(or)

•	 By	clicking	the	tool	icon:	     (or)

•	 By	using	the	P keyboard shortcut.

To CREATE A NEW FILE 

1. Click on File Menu 

2. Select New option 

3. Type the height or width / choose a template 

4. A dialog box appears, using this you can select the template and specify the size by setting values for both height 

and width. 

ACTIVITY 1

A new blank image file is created. Now, you can use the tools and create your own drawings.

Steps to follow

1. Create a  new blank canvas.( File  -new ---ok)

2. Select the Paintbrush tool and select the Star shape in the Brushes dialog and draw a few shapes like this:

3. Change the brush to Opacity : 60%.(Opacity means reducing the intensity of color) 

4. Create another star as shown here:
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5. Reduce the brush size to 40%.

6. Create a few stars as shown here:

7. Choose a color from the Ega palette and create a few colored stars:

8. Close the picture without saving it.

 Click here to 
close the 
canvas. 

 Click here  
not to save 
the changes. 

 

hoW To ACTIVATE TooL Box

1. From the Tools  menu, choose Tool box  (or)

2. By using the keyboard shortcut Ctrl + B.

SELECTIoN TooLS

Selection tools are designed to select regions from images or layers so you can work on them without affecting the 

unselected areas. Each tool has its own individual properties, but the selection tools also share a number of options 
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and features in common. There are seven selection tools in GIMP.  They are Rectangle, Ellipse, Free Select (Lasso), 

Fuzzy select (The /magic wand), Select by color, Scissors select and Foreground Select tool.  Now we will discuss 

about Rectangle and Ellipse tool.

•	 The	Rectangle	Selection	tool	is	designed	to	select	rectangular	regions	of	an	image:	it	is	the	most	basic	of	the	

selection tools, but very commonly used. 

•	 The	Ellipse	Selection	tool	is	designed	to	select	circular	and	elliptical	regions	from	an	image,	with	high-quality	

if you want.

ACTIVITY 2

Steps to follow

1. Create a new canvas.

2. Change the Foreground color to Blue and Background color to Green.

3. Draw the following shapes:

 
Use the rectangle 
selection tool and 
stroke the 
selection with 2 
pts. 

 
Use the Rectangle 
selection tool and 
choose Stroke line 
Pattern. 

 
Use the Ellipse 
selection tool and 
stroke the 
selection with 2 
pts. 

 
Use the Ellipse 
selection tool and 
fill with the 
foreground color. 

•	 GIMP	is	open	source	software	that	allows	us	to	manipulate	images.

•		 GIMP	has	two	modes:	Single	window	and	Multi-window	mode.

•		 GIMP	terminologies:	Image,	Layers,	Selection.

•		 The	paint	brush	tool			paints	fuzzy brush strokes. All strokes are rendered using the current brush.

•		 GIMP’s	native	file	format	is ‘XCF ’.

•		 Selection tools are designed to select regions from images or layers so you can work on them without affecting 

the unselected areas.
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 BRAIN dEVELoPER 

I. MuLTIPLE ChoICE QuESTIoN:
1. What does GIMP stand for?

 a) GNU Image Making Program

 b) GNU Image Masking Program

 c) GNU Image Multiplication Program

 d) GNU Image Manipulation Program

2. Which drop menu in GIMP, has the option to enable single-window mode?

 a) Configure b) File c) Edit d) Windows

3.  Which of the following is GIMP’s native format?

 a) xcf b) png c) jpeg d) xcg

4. What is the default pixel size of the canvas?

 a) 640x400 b) 400x600 c) 600x300 d) 650x350

5. How many window modes are there in GIMP?

 a) Three b) Five c) Two d) None of these

II.FILL IN ThE BLANKS WITh ThE hELP oF hINTS gIVEN BELoW:

1. Ellipse and Rectangle tool are the  _______________________ tools.

2. ________________ is the heart of GIMP.

3. _______________ is similar to Adobe Photoshop.

4. _______________ is the OS with which we are loading GIMP.

5. GIMP is an _______________ editing software.

Teacher’s Signature

•	 Image	 •	 Selection	 •	 Gimp	
•	 Windows	 •	 Tool	box
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LEARNINg oBjECTIVES

•	 Introduction	to	Layers

•	 Benefits	of	Layers

•	 Layers	Panel

•	 Selection	tools

INTRoduCTIoN
In GIMP, a single picture may be made up of several layers. A layer can be compared to a transparent sheet on 

which you can draw something. Each layer can have different pictures and when you stack them up one on top of 

the other; it forms a single comprehensive picture. 

ThE BENEFITS oF LAyERS
•	 Layers	give	you	more	control	and	flexibility	over	your	image	compositions.

•	 Layers	enable	you	to	stack	images	on	top	of	other	images	—	all	within	the	same	image.	Therefore,	you	can	
have multiple layers of images, stacked on top of each other.

•	 But	most	importantly,	each	layer	can	be	transparent	or	semi-transparent	as	required.	Therefore,	despite	having	
layers on top of others, you are still able to see the other layers beneath them.

•	 Layers	enable	you	to	add	and	remove	parts	to	your	image	without	affecting	the	rest	of	the	image.	They	help	
you experiment with different effects. If you find that something doesn’t work, you can just delete the layer (or 
hide it) - the rest of the image is still intact.

ExAMPLE oF LAyERS

Let’s take the following image:

WoRKINg WITh  
LAyERS Ch

ap
te

r

2
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This image contains three layers: one for the background, one for the oval shape, and one for the text.

ThE LAyER BouNdARy Box

An image file can contain many layers but you can only work on one layer at a time. GIMP indicates which layer 

you are on by placing a Layer Boundary box around the image layer. However the box only covers the pixel area of 

the layer as shown here.

In	the	first	image	the	flower	layer	is	selected	indicated	by	the	Layer	Boundary	box	that	surrounds	the	whole	image.	

When	the	butterfly	layer	is	selected	the	box	only	extends	around	the	butterfly	image	itself	because	that	is	the	only	

area on that layer that contains any pixels. Layers are selected through the Layers Panel described below.

ThE LAyERS PANEL

The Layers Panel (Dialog box) contains layer options that can be applied to layers, such as layer visibility, locking 

layers, deleting/adding layers, changing the stacking order, applying merge mode effects, controlling layer opacity 

and merging layers.

Some	examples	of	the	various	layer	options	applied	to	the	butterfly	layer:
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ACTIVITY 1:

In this exercise we are going to create a logo for a company called “green Leaf Ltd”.

Steps to follow

1. Create a new blank image.

2. Draw a brown square using Rectangle tool and then from Edit menu; choose ‘Stroke Selection’ option. In the 

Stroke Selection menu, choose stroke line and line width as 1.0 pixel and then click stroke.

3. Change the name of the layer to “Bg with square”. (Double click on the layer name and type the new 
name) 

The Stroke Selection command strokes a 

selection in the image. This means that the 

selection border, which is emphasized in the 

image with a dotted line, can be drawn with 

a stroke. 
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4. Create a new layer (Layer New Layer). While creating the layer, name the layer as “Circle”.

5. Draw a circle using Ellipse tool, then fill it with green color using Bucket Fill tool.

6. Create another new layer (Layer New Layer). 

7. Type the text “green Leaf Ltd.” as shown below:
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8. Format the text as shown here:

9. Delete the layer called Name. (Right click on the layer name and choose delete Layer) 

10. Make the circle layer invisible. (Click the eye icon )

The circle layer is made invisible:

11. Now make the Bg with square layer also invisible.

12. Now make the circle layer visible. (Click the square in the place of the eye icon)

 

 Eye icon  – 
To make the layer 
visible / invisible 
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13. Make the square layer visible too.

14. Reduce the opacity of the circle layer to 65%. (Select the circle layer and drag the opacity marker to the left 
till it reaches 65%)

15. Bring the green Leaf Ltd. layer down below the Circle layer. (Select the layer, then choose Layer  Stack 
Lower Layer).

This is how the image should look:

16. Merge all the layers. (Image Merge Visible LayersMerge).

The Merge Visible Layers command merges 

the layers which are visible into a single layer. 

Visible layers are those which are indicated 

on the Layers dialog with an “eye” icon.
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The image should like this with only one the base layer as the layer name.

17. Save the file as greenleaflogo.xcf

•	 In	GIMP	terminology,	each	individual	transparency	is	called	a	Layer.

•	 GIMP	indicates	which	layer	you	are	on	by	placing	a	Layer	Boundary	box	
around the image layer.

•	 The	Layers	Panel	(Dialog	box)	contains	layer	options	that	can	be	applied	
to layers.

•	 You	can	also	just	merge	a	single	layer	downward	into	another,	one	a	time,	
if you don’t need all the layers to be merged.

•	 Visible	layers	are	those	which	are	indicated	on	the	Layers	dialog	with	an	“eye”	icon	 .



66

 BRAIN dEVELoPER 

I) MATCh ThE ShoRTCuTS:
1.   -  Creating a new layer           

2. CTRL + X  - Eye icon

3. Shift + Ctrl + N  -  Short cut key - E

4. Activate Ellipse tool - CUT

5. CTRL + C -   Activate tool box

6. CTRL + Z - PASTE

7. CTRL + Y - Reverse the last action

8. CTRL + M - Repeats the last action

9. CTRL + B  - Merge all visible layers

10.  CTRL + V  -  COPY

II) WRITE doWN ThE ExPANSIoNS oF ThE FoLLoWINg :

 .gif    - __________________________________________________

 .png - ___________________________________________________

 .jpeg- ___________________________________________________

 .bmp - ___________________________________________________

 .xcf   - ___________________________________________________

Teacher’s Signature
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LEARNINg oBjECTIVES
•	 To	know	about	the	Tool	Box	and	Tool	Icons.

•	 Methodology	of	using	Foreground	and	Background	Color.

•	 How	to	use	the	Text	Tool	and	Blend	tool.

•	 To	merge	different	Layers.

INTRoduCTIoN

GIMP has a “Toolbox” to quickly perform basic tasks. Toolbox is customizable, this means that you can add / re-

move any tool you want. The Toolbox is the heart of GIMP. To select tools for doing something, go to the “Tools” 

menu, and select any tool you want. To put the tool on the panel go to “Edit > Preferences > Toolbox”.

ThE TooLBox

Figure : Screenshot of the Toolbox
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In the Toolbox, as in most parts of GIMP, moving the mouse over something and let-

ting it rest for a moment, usually displays a “tooltip” that describes the thing. Short cut 

keys are also frequently shown in the tooltip. In many cases, you can move the mouse 

over an item and press the F1 key to get help about the thing that is underneath the 

mouse.

By default, only the Foreground-background icon is visible

Tool icons: These icons are buttons which activate tools for a wide variety of purposes: selecting parts of images, 

painting an image, transforming an image, etc.  “The Toolbox”  gives an overview of how to work with tools.

1. Foreground/Background colors: The color areas here show you GIMP’s current foreground and background 

colors, which come into play in many operations. Clicking on either one of them brings up a color selector 

dialog that allows you to change to a different color. Clicking on the double-headed arrow swaps the two colors, 

and clicking on the small symbol in the lower left corner resets them to black and white.

2. Brush/Pattern/Gradient: The symbols here show you GIMP’s current selections for: the Paintbrush, used by all 

tools that allow you to paint on the image (“painting” includes operations like erasing and smudging, by the 

way); for the Pattern, which is used in filling selected areas of an image; and for the Gradient, which comes 

into play whenever an operation requires a smoothly varying range of colors. Clicking on any of these symbols 

brings up a dialog window that allows you to change it.

3. Active Image: In GIMP, you can work with many images at once, but at any given moment, only one image is 

the “active image”. Here you find a small iconic representation of the active image. Click the icon to display a 

dialog with a list of the currently open images, click an image in the dialog to make it active. Usually, you click 

an image window in multi-window mode, or an image tab in single-window mode, to make it the active image.

The “Active Image” preview is disabled by default. If you want it, you can enable it in the Toolbox Preferences tab.

TExT TooL    

The Text tool places text into an image.  When you click on an image with this tool the Text Editor dialog is opened 

where you can type your text, and a text layer is added in the Layer Dialog.  In the Text option dialog, you can 

change the font, color and size of your text, and justify it, interactively.

Figure:  Text tool in Toolbox
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ACTIVATINg ThE TExT TooL

You can access this tool in several ways:

•	 Tools Text

(or)

•	 By	clicking	the	tool	icon	  in Toolbox

(or)

•	 By	using	the	T keyboard shortcut.

You can also click-and-drag the color from the Toolbox color area onto the text.

BLENd/ gRAdIENT TooL 

The Blend/Gradient tool  fills the selected area with a gradient blend of the foreground and background colors by 

default, but there are many options. To make a blend, drag the cursor in the direction you want the gradient to go, 

and release the mouse button when you feel you have the right position and size of your blend. The softness of the 

blend depends on how far you drag the cursor. The shorter the drag distance, the sharper it will be.

The two most important options you have are the Gradient and the Shape.  Clicking the Gradient button in 

the tool options brings up a Gradient Select window, allowing you to choose from among a variety of gradients 

supplied with GIMP; you can also construct and save custom gradients.

For Shape, there are 11 options: Linear, Bi-linear, Radial, Square, Conical (symmetric), Conical (asymmetric), 

Shaped (angular), Shaped (spherical), Shaped (dimpled), Spiral (clockwise), and Spiral (counterclockwise).

In GIMP 2.10 

Blend Tool is 

named as  

Gradient Tool
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ACTIVITY 1:

Placing a picture into the text. This method is very basic and easy to follow.

Steps to follow:

Step 1: Load your background image in to GIMP.

Step 2: Go to Layers on the Menu bar and select “Create a New Layer” (Transparency).
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Step 3: Select the Blend tool and choose a gradient with just a blend of two colors. Drag the gradient across the 

transparent layer.

Step 4: Move the opacity slider to the left so that you can just see the photo background layer for positioning 

where you want your text to be placed.
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Step 5: Select the Text tool, choose a heavy bold font, increase its size (depending on the photo size), position the 

text cursor on the blend layer dialog box and type your text.

Step 6: Right click the Text layer and choose “Alpha to selection” option.
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Step 7: Select the blend layer and increase the Opacity to 82%. This change is necessary to cover the background 

image.

Quick View : The Alpha to Selection command creates a 

selection in the current layer from the alpha channel, which 

encodes transparency. It means that you will be selecting all 

colors that aren’t transparent in your current layer - which is 

just your text.



74

Step 8: Now choose the Text layer (top layer), right click the mouse button and select ‘Merge Down’ option.  

This merges the text layer and the blend layer as one layer.

Quick View : The Merge down command merges the active 

layer with the layer just below it in the stack, taking into 

account the various properties of the active layer, such as its 

opacity and layer mode.
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Step 9: Press the Delete key from the keyboard, which deletes the text and reveals the image below. 

Step 10: From Edit menu, choose ‘Stroke Selection’ option.

Quick View : The Stroke Selection command strokes a 

selection in the image. This means that the selection border, 

which is emphasized in the image with a dotted line, can be 

drawn with a stroke.
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Step 11: In the Stroke Selection menu, choose stroke line and line width as 1.0 pixel and then click stroke.

Step 12: Gimp places a black line around your text.
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Step 13:  From the Select menu, choose ‘none’ option.  This turns off the selection.

Step 14: Right click on the Top layer and click ‘Flatten image’ option.

Quick View : The Flatten Image command merges all of the 

layers of the image into a single layer with no alpha channel 

(transparency).



78

The final output will be shown as below

Step 15:  Save the file as a normal jpg file (FileSave) and close the application.

RECAP
•	 GIMP has a “Toolbox” to quickly perform basic tasks. 

•	 The Blend/gradient tool  fills the selected area with a gradient blend of the foreground and background 

colors. 

•	 The Text tool   places text into an image.

•	 The Stroke Selection command strokes a selection in the image.

•	 The Merge Down command merges the active layer with the layer just below it in the stack, taking into ac-

count the various properties of the active layer, such as its opacity and layer.
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 BRAIN dEVELoPER 

I) MuLTIPLE ChoICE QuESTIoNS:

1.  What is this image called ?

 a) Tool option b) Tool box c) Menu d) Navigation window

2. Tools - Short cut keys are also frequently shown in the _________.

 a) Tool tips b) Tool options c) Canvas d) Tab

3. The ______________ fills the selected area with a gradient blend of the foreground and background colors.

 a) Blend tool b) Bucket fill tool c) Paint brush tool d) Brush tool

4. The __________ command merges all of the layers of the image into a single layer with no alpha channel 

 (transparency).

 a) Merge down b) Flatten Image c) Delete layer d) Duplicate layer

5. The two most important options you have are the Gradient and the Shape in Blend tool option dialog box. 

 There are _________ options in shape.

 a) Ten b) Eleven c) Nine d) Twelve

II) STATE TRuE oR FALSE:

1. Stroke selection is under Edit menu     

2.    is Paint brush tool  

3. Short cut key to activate Text tool is S.   

4. More than one image can be the “active image”.

5. The text color can be changed, by just  

 click-and-drag the color from the Toolbox color area onto the text.

Teacher’s Signature
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LEARNINg oBjECTIVES

•	 Brush	tools	in	GIMP.

•	 Paint	brush	tool.

•	 Creating	a	new	brush	tool.

INTRoduCTIoN

The GIMP contains many brush tools. The feature they all have in common is that all of them are used by moving 

the pointer across the image display, creating brushstrokes. The Pencil, Paintbrush, Airbrush, and Ink tools – be-

have like the intuitive notion of “painting” with a brush. The others use a brush to modify an image in some way 

rather than paint on it. Eg. The Eraser tool – erases the content etc..….

The paint brush tool paints fuzzy brush strokes. All strokes are rendered using the current brush.

Figure : Paintbrush

ACTIVATE PAINT BRuSh TooL:

You can activate the Paintbrush Tool in any one of the following order: 

•	 Tools	menu	->		Paint	Tools	->Paintbrush	(or)

•	 By	clicking	the	tool	icon:	  (or)

•	 By	using	the	P	keyboard	shortcut.

CREATINg A  
NEW BRuSh TooLCh

ap
te

r

4
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KEy ModIFIERS (dEFAuLTS)

Ctrl  :  This key changes the paintbrush to a Color Picker.

Shift : 

	 •	 This	key	places	the	paintbrush	into	straight	line	mode.	Holding	Shift	while	clicking	Button	1	will 

  generate a straight line.

	 •	 Consecutive	clicks	will	continue	drawing	straight	lines	that	originate	from	the	end	of	the	last	line.

Paint brush tool options: The available tool options can be accessed by double clicking the  

Paintbrush Tool icon.   

Figure : Paint brush tool options

ACTIVITY 1:

This exercise helps us to create twinkling stars using newly created sparkle brush tool.

Steps to follow

Step 1: First load your image in to GIMP 2.8
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Step 2: Click the Paint brush tool icon  .

Step 3: In the Brushes dialog box, choose the “Hardness 0.25” option.
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Step 4: In the Brushes tab, Right click on the shape and choose the ‘New brush’ option (or) Click the “Create 

New Brush” icon at the bottom of the brush dialog box.
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Step 5: Click the Diamond shape form.

Step 6: Set the Radius to 75.0, spikes to 4, Hardness to 0.09, Aspect ratio to 1.6, angle to 106.0, spacing to 20 

in the dialog box.
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Step 7: From the layer menu, choose ‘create a new layer’ option (Layer Fill type-Transparency) and then click ok.

Step 8: Change the foreground color as white and place the sparkle brush on your picture to get twinkling stars.

 

Transparency : The opacity slider controls the transparency 

or opaqueness of a specific layer. This will not affect the 

internal alpha channel of the layer.
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The final output of creating twinkling stars using sparkle brush tool effect….

Using this sparkle brush “Christmas card” can also be created. You can also create different types of brushes like 
this and create as many effects as you can.
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•	GIMP	allows	you	to	use	several	different	types	of	brushes,	which	are	described	in	the	
Brushes section. 

•	Brush	tool	-	Key	modifiers	:	Ctrl	,	Shift	key	etc.

•	Tool	options	shared	by	all	brush	tools	:	Opacity,	Mode,	Brush,	Size,	Aspect	ratio,	Angle	
etc…

•	 Different	types	of	brushes	can	also	be	created	for	editing.

 BRAIN dEVELoPER 

I) MuLTIPLE ChoICE QuESTIoNS:

1. Which keyboard key is to be pressed while making a straight ine using brush tool?

 a) Alt key b) Ctrl key c) Shift  key d) Tab  key

2. What are the default  foreground/background colors when you open a blank file in GIMP?

 a) Black Foreground & Black Background b) White Foreground & Black Background

 c) Black Foreground & White Background d) White Foreground & Black Background

3. What is in this image ?

 a) Tool box b) Tool options c) Brush options  d) Layers

4. The Tool options box:

 a) Is the same for every tool b) Changes depending on what tool you select

5. The __________ key changes the paint brush tool to a color picker.

 a) Ctrl  b) Shift  c) Tab  d) Enter 

Teacher’s Signature
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LEARNINg oBjECTIVES
•	 Introduction	to	Image	Editor

•	 Image	editor	features

•	 Knowing	about	Quick	Mask	Button

•	 Effects	of	applying	a	Filter.

•	 How	to	invert	an	Image.

INTRoduCTIoN
Image editors can change the pixels to enhance the image in many ways. There are many tools that can be used for 

editing images in GIMP. The most commonly used tools are brush tools, Blend tool, Bucket fill tool etc… 

GIMP also provides “smart” tools that use a more complex algorithm to do things that otherwise would be time 

consuming or impossible. These include Perspective, Blur and sharpen etc…

IMAgE EdIToR FEATuRES
Listed below are some of the most used capabilities of the better graphics manipulation programs. 

•	 Using	 a	 selection	 tool,	 the	 outline	 of	 the	 figure	 or	 element	 in	 the	 picture	 is	 traced/selected,	 and	 then	 the	

background is removed.

•	 Photo	manipulation	packages	have	functions	to	correct	images	for	various	lens	distortions	etc....

•	 Images	may	be	skewed	and	distorted	in	various	ways.	Scores	of	special	effects	can	be	applied	to	an	image	which	

includes various forms of distortion, artistic effects, geometric transforms and texture effects, or combinations 

thereof.

•	 Image	 editors	have	provisions	 to	 simultaneously	 change	 the	 contrast	of	 images	 and	brighten	or	darken	 the	

image

•	 Digital	editors	are	used	to	crop	images.	Image	editors	can	resize	images	in	a	process	often	called	image	scaling,	

making them larger, or smaller.

•	 Image	editors	are	capable	of	altering	an	image	to	be	rotated	in	any	direction	and	to	any	degree.

The corrections are in most cases subtle, but can improve the appearance of some photographs...

QuICK MASK BuTToN
The Quick Mask is GIMP’s way of showing the full structure of the selection. Quick Mask also provides the ability 

to interact with the selection in new, and substantially more powerful, ways. Click the small outlined button at the 

lower left of the image window to toggle Quick Mask on and off. The button switches between Quick Mask mode, 

BASIC IMAgE  
EdITINg5Chapte

r
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and marching ant’s mode. You can also use Select Toggle Quick Mask, or Shift + Q, to toggle between Quick 

Mask and marching ant’s mode.

FILTER CoMMANd
A filter is a special kind of tool designed to take an input image, apply a mathematical algorithm to it and return 

an image in a modified format. GIMP uses filters to achieve a variety of effects.

ACTIVITY 1:

This worksheet shows how you can do vignette effects using a feature of GIMP called Quick Mask. It lets you 

make very precise adjustments to your selections. It’s intended to show how we can use it to create quick and easy 

vignette effects.

Steps to Follow:

Step 1:  Load an image in to GIMP 2.8

Step 2:  First, make a rectangular selection around the edge of the image using Rectangle Tool. 
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Then click on the red-bordered Quick Mask icon in the lower-left corner of your image.

  Quick Mask Tool is 
an excellent tool for 

refining the  
complicated selection
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Step 3:

After you click the red Quick Mask button, a translucent red mask appears around your selection.  This red mask 

represents the outside of your selection.  When you click the dashed Quick Mask button to go back into normal 

selection mode, anything red will not be selected. Right clicking the Quick Mask Button brings up the menu 

which allows us to toggle the mask, change its color and to invert the coloration.

So, let’s start playing with this mask using filters option. 

First, right click on the image and select

Filtersdistorts Waves

Finally, click the ok button and watch what happens to the mask. 

The mask gets all wavy.

Step 4:  Let’s add one more effect:

Filters - Blur -   gaussian Blur (RLE).
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Now that there is a soft edge on the mask.

Step 5: Click the dashed Quick Mask button to convert the mask back into a selection.

See how the selection follows the mask?  This is a powerful feature of Quick Mask.  You can use it to modify any 

existing selection, and you can even use it to create new selections.  

Step 6: From the Select menu, choose ‘Invert’ option and then from Edit menu, choose ‘Fill with BG color’ option 

(where the bgcolor is white).
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The result, a soft white fade into the background, is shown in the final step.

Some more examples are listed below for the various filter options:

Choose, Filters – Noise – Spread, with horizontal and vertical settings at 11, to get the following effect.

Choose, Filters – distorts – Newsprint plug-in to get the following effect.

The Invert command inverts the selection in the current layer. It means that 

all of the layer contents which were previously outside of the selection are now 

inside it, and vice versa. If there was no selection before, the command selects 

the entire layer.
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Now use, Filters – Blur –  Pixelize  to get the following effect.

 Image editors can change the pixels to enhance the image in many ways.

 Quick Mask Tool is an excellent tool for refining the complicated selection.

 QMB is a toggle button located on lower left corner.

 Several types of Image Effects can be applied using GIMP.

 Shift +Q is the shortcut key to invoke QMB.

 The Invert command inverts the selection in the current layer.
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 BRAIN dEVELoPER 

SAy  yES oR No:

1. Quick Mask Button is located at the lower left corner of the image window.

2. Only seven types of effects can be applied to the images in GIMP.

3. Shift + Q will invoke the Quick Mask Button.

4. Foreground and Background colors can be swapped in GIMP Image window.

5. Filters -DistortsWavy will change the entire image wavy.

Teacher’s Signature
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LEARNINg oBjECTIVES
•	 Introduction	to	Transform	Tool.

•	 Features	of	Transform	Tool.

•	 Also	about	Scale	Tool	and	Crop	Tool.

•	 Usage	of	Layers.

INTRoduCTIoN
General transformations of a layer can be done using the Transform tools from the Toolbox. This tool can perform 

rotation, scaling, shearing, and perspective transformations of the active layer. As usual, care must be taken to 

specify the active layer before applying this tool. 

Common Features
Figure : An overview of the transform tools

Inside the Transformation tool dialog, you will find nine tools to modify the presentation of the image or the 

presentation of an element of the image, selection, layer or path. Each transform tool has an Option dialog and an 

Information dialog to set parameters.

Tool options
Figure : Common options of transform tools

TRANSFoRM TooLS -  I6Chapte
r
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Some options are shared by several transform tools. We will describe them here. 

GIMP offers you three buttons which let you select which image element the transform tool will work on.

•	 When	you	activate	the	first button   the tool works on the active layer. If no selection exists in this 

layer, the whole layer will be transformed.

•	 When	you	activate	the	second button   the tool works on the selection only (the whole layer if no 

selection).

•	 When	you	activate	the	third button,   the tool works on the path only.

Now we will discuss about some of the Transform tools.

Scale Tool   
The Scale tool is used to scale layers, selections or paths(the object).  When you click on image with the tool the 

scaling information dialog box is opened, allowing to change separately width and height.  At the same time a 

preview (possibly with a grid or an outline) is superimposed on the object and handles appear on corners and 

borders that you can click and drag to change dimensions.  A small circle appears at center of the preview allowing 

to move this preview.

Activating the tool:
You can access to the Scale Tool in different ways:

•	 Tools		->		Transform	Tools	->	Scale

(or)

•	 By	clicking	the	tool	icon	:	   in the Toolbox

(or)

•	 By	using	the	Shift	+	T	short	cut	key

Crop Tool      
The Crop Tool is used to crop or clip an image. It works on all the layers of the image, visible and invisible. This tool 

is often used to remove borders, or to eliminate unwanted areas to provide you with a more focused working area.

Just like the selection tools, the crop tool can be used. The resize handles actually resize the crop rectangle instead of 
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providing both resize and move functionality. The tool behaves more naturally and consistently with other GIMP 

tools. To move, simply drag the rectangle clicking within the area. Resizing is possible in one or two axes at the 

same time dragging the handle-bars on the sides and corners. The outside area can be darkened with a nice passé 

partout effect to better get the idea of how the final crop will look like. To validate cropping, click inside the crop 

rectangle or press the Enter key.

Activating the Tool
You can activate crop tool in different ways:

•	 Tools	Transform tools  Crop

(or)

•		 By	clicking	the	tool	icon	:		  in the Toolbox

(or)

•		 By	using	the	keyboard	shortcut	Shift	+	C.

Activity 1:

In this exercise, the image is squeezed up to the smaller size, but to the viewer the background appears normal. This 

is done by using the Scale tool, Selection tool, Crop and Text tool.

Steps to Follow

Step 1: Load your image into GIMP. Duplicate your image by clicking the “Duplicate” icon/Duplicate Layer.     

   
Duplicate layer/icon: This lets you duplicate the 
current selected layer. Short cut key-Shift+Ctrl+D 
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Step 2:  Select the “Scale” tool and scale your photo by pushing the center node to the right. Squeeze it up, to half 

of the normal image, and then click “Scale”.
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Step 3: Go to “Layers” on the menu bar, scroll down and click “Mask” option, then click “Add Layer Mask”. 

Accept the default settings and click Add button.  

Layer masks in GIMP (GNU 
Image Manipulation Program) 
provide a flexible way to edit 
layers that combine within 
a document to produce more 
attractive composite images. 
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Step 4: Right click the top layer and choose “Merge down” option.

Step 5: Select the “Crop” tool from the tool box, drag a selection over the squeezed image and press “Enter” key 

to crop the photo.
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The picture is now cropped.

Step 6: Using Text tool    give a title to the picture.
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Step 7: Right click the top layer from the layer dialog box, click the last option “Flatten Image”.
 

The Flatten Image command merges all of the layers of the image into a 
single layer with no alpha channel (transparency). 

 

Step 8: Got to “File” and choose “Export” to save your photo in ‘png’ format.
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RECAP  

•	 The	transform	tools	can	perform	rotation,	scaling,	shearing,	and	perspective	transformations	of	the	active	

layer.

•		 The	Flatten	Image	command	merges	all	of	the	layers	of	the	image	into	a	single	layer	with	no	alpha	channel	

(transparency).

•		 Layer	masks	in	GIMP	provide	a	flexible	way	to	edit	layers	that	combine	within	a	document	to	produce	more	

attractive composite images.

•		 The	Merge	Down	command	merges	the	active	layer	with	the	layer	just	below	it	in	the	stack,	taking	into	

account the various properties of the active layer, such as its opacity and layer.

 BRAIN dEVELoPER 

I) MuLTIPLE ChoICE QuESTIoNS:

1. What is the short cut key combination in GIMP, to crop an image?

 a) Shift + C b) Shift + F c) Shift + T d) Shift + R

2. What is the use of cropping an image?

 a) Fitting an image to fill a frame  b) Removing a portion of the background

 c) Emphasize the subject   d) All of these

3. What is the short cut key combination in GIMP, to Scale an image?

 a) Shift + C b) Shift + R c) Shift + F d) Shift + T

4. Using “Crop” tool, drag a selection over the picture and press _______________ key to crop the picture. 

 a) Tab b) Enter c) Shift  d) Back space

5. __________________ Layer is used to duplicate the current selected layer.

 a) Merge b) Delete c) Duplicate d) New
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II)  MATCh ThE FoLLoWINg:

  -  Wilber(GIMP icon)

  - Scale tool

  - Text tool

  - Crop tool

  - Move Tool
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LEARNINg oBjECTIVES
•	 Knowing	about	Transform	Tool.

•	 Also	about	Move	Tool,	Rotate	Tool.

•	 Bucket	Fill	Tool	and	its	features.

•	 Making	Collage	Effect	in	a	single	Image.

INTRoduCTIoN
Transform tools, which alter the geometry of the image. In this chapter we will be discussing about Move and 

Rotate tool of transform tools. As usual, care must be taken to specify the active layer before applying this tool.

Move Tool   
The Move tool is used for moving anything on the image, including layers, selections and paths.

Figure : Move Tool options

•	 Move - defines what will be moved

•	 Tool Toggle - toggle between the two available modes (for each option)

You can toggle between the two options with Shift (temporarily).

TRANSFoRM TooLS -  II7Chapte
r
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Activating the Tool
You can access the Move Tool in different ways:

•	 Tools	 Transform Tools  Move

(or)

•	 By	clicking	the	tool	icon:	   .

(or)

•	 By	using	the	keyboard	shortcut	M.

The Move tool is automatically activated when you create a guide.

Holding down the Space bar changes the active tool to Move temporarily. The Move tool 

remains active as long as the space bar is held down. The original tool is reactivated after 

releasing the space bar. This behavior exists only if the Switch to Move tool option is enabled 

in Edit Preferences Image Windows Space Bar.

Note

Rotate Tool    
The Rotate tool is used to rotate the active layer, a selection or a path. When you click on the image or the selection 

with this tool, a grid or an outline is superimposed and a Rotation Information dialog is opened. There, you can set 

the rotation axis, marked with a point, and the rotation angle. You can do the same by dragging the mouse pointer 

on the image or the rotation point.

Activating the tool
 Tools Transform Tools  Rotate

 By clicking the tool icon:   in the Toolbox.

 By using the Shift-R key combination.

Bucket fill tool   
The Bucket fill tool fills a selection with the current foreground color. If you Ctrl+click and use the Bucket fill tool, 

it will use the background color instead. Depending on how the tool options are set, the Bucket Fill tool will either 

fill the entire selection, or only parts whose colors are similar to the point you click on. The tool options also affect 

the way transparency is handled.

Activating the tool
•	 Tools	 Paint Tools  Bucket Fill

(or)

•	 By	clicking	the	tool	icon	:	  in the toolbox.

(or)

•	 By	pressing	the	Shift + B short cut keys.
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Key modifiers
•	 Similarly	to	paint	tools,	pressing	Ctrl	allows	you	to	pick	surrounding	colors	on	canvas	without	having	to	switch	

to Color Picker tool.

•	 Shift	toggles	the	use	of	Fill	Similar	Color	or	Fill	Whole	Selection	on	the	fly.

•	 Alt toggles Fill type between FG and BG colors

Normally, tool options are displayed in a window attached under the Toolbox as soon as you activate a tool. If they 

are not, you can access them from the menu bar through Windows  Dockable Windows  Tool Options which 

opens the option window of the selected tool.

“Bucket Fill” tool options
Fill Type

GIMP provides three fill types:

•	 FG Color Fill - sets the fill color to the currently selected foreground color.

•	 BG Color Fill - sets the fill color to the currently selected background color.

•	 Pattern Fill - sets the fill color to the currently selected pattern. You can select the pattern to use in a drop 

down list.

Affected Area
•	 Fill whole selection: This makes GIMP fill a pre-existent selection or the whole layer. 

•	 Fill similar colors: This is the default setting: the tool fills the areas with a color near the pixel onto you have 

clicked. The color similarity is defined by options in Finding Similar Colors.

Activity 1

This exercise help us to create a Collage Effect by using single image.

Steps to Follow

Step 1: Load your image into GIMP.
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Step 2: Select the layers menu and choose ‘Create a new layer’ option (Transparency).

Step 3: Using the ‘Rectangle tool’, select a portion of the picture on the transparency layer.

Step 4: Using the ‘Bucket Fill’ tool, fill the selection with white color (change the foreground color as white).
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Step 5: Again using the ‘Rectangle’ tool, select the inner portion.

Step 6: After selection, press the delete key from the keyboard to delete the selected inner portion.
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Step 7: Using the Rectangle tool, drag a selection around the outer border, then go to Edit menu and choose 

Copy option.

Step 8: Now, Choose Paste option from the Edit menu.
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Step 9: In the layers dialog box you have a “Floating selection (pasted layer)”, now click ‘Create a new layer’ icon 

at the bottom of the dialog box. Now select the layer you first made, and then just click the ‘Waste Bin’ icon at 

the bottom of the dialog box.

Step 10: Make sure you have selected the top layer, and then duplicate the layer for 4 or 5 times.
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Step 11: Go to the layers dialog box and select the layer one by one and repeat the procedure.

i) Select the Move tool   from the tool box, make sure ‘Move the active layer button’ is selected and move 

the frame to a new position.

ii) Select the Rotate tool  from the tool box and tilt the frame.

 (Repeat step 11 for all the layers)
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Step 12: In the layers dialog box, turn off the ‘Eye’ icon of the bottom layer.

Step 13: Right click the top most layer and choose ‘Merge visible layer’ option.

 
The Merge Visible Layers command merges the 
layers which are visible into a single layer. 
Visible layers are those which are indicated on 
the Layers dialog with an “eye” icon. 
(Keyboard shortcut Ctrl + M ) 
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Step 14: Turn on the ‘Eye’ icon of the bottom layer.

Step 15: Select the top layer, right click, from the drop down dialog option select ‘layer to image size’ option.

 
The “Layer to Image Size “ command resizes the 
layer boundaries to match the image boundaries, 
without moving the contents of the layer with respect 
to the image. 
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Step 16: Select the top layer which is the transparency with the collage frames. Go to the tool box and select the 

‘Bucket Fill’ tool. You can fill the background with color of your choice or choose patterns from the pattern palette.

The final output is…………….
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Recap
•	 General	transformations	of	a	layer	can	be	done	using	the	Transform	tools	from	the	Toolbox.

•	 The	Move tool is used for moving anything on the image, including layers, selections and paths.

•	 The	Rotate tool is used to rotate the active layer, a selection or a path.

•	 The	Bucket fill tool   fills a selection with the current foreground color

•	 Visible	layers	are	those	which	are	indicated	on	the	Layers	dialog	with	an	“eye”	icon.

•	 Waste	bin	icon	is	located	at	the	bottom	of	the	Layer	dialog	window.
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 BRAIN dEVELoPER 

I) FILL IN ThE BLANKS:
1. The ____________tool is used for moving anything on the image, including layers, selections and paths.

2. The ______ Tool is used to rotate the active layer, a selection or a path.

3. The_____________ command merges the layers which are visible into a single layer.

4. To move a selected image, make sure ___________ button is selected.

5. _________ Tools, which alter the geometry of the image.

   Rotate     Move the active layer  
   Transform   Merge Visible layers  
   Move

II) SAy yES oR No:
A. Holding the space bar key toggles between the active tool and move Tool. (Y/N)   

B.   Is a move Tool.(Y/N)

C. By pressing the Ctrl + click and use the Bucket fill tool, it will use the Background color instead of Foreground 

color.(Y/N)

D. Alt key shifts between FG color and BG color. ( Y/N)

Teacher’s Signature
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LEARNINg oBjECTIVES
•	 Knowing	the	purpose	of	using	Flip	tool,	Scale	tool	and	Move	tool.

•	 List	the	features	of	Alpha	channel.

•	 How	to	use	Filter	options.

•	 List	the	usage	of	different	layers.

FLIP TooL  
The	Flip	tool	provides	the	ability	to	flip	layers	or	selections	either	horizontally	or	vertically.	When	a	selection	is	

flipped,	a	new	layer	with	a	Floating	Selection	is	created.	You	can	use	this	tool	to	create	reflections.

Activating the Tool
You can access the Flip Tool in different ways:

•	 From	the	Tools->	Transform	Tools->	Flip	(or)

•	 By	clicking	the	tool	icon:		   in Toolbox (or)

•	 By	using	the	Shift + F key combination.

Use	this	option	when	you	need	the	image	at	the	top	of	the	image	to	be	the	bottom.	After	selecting	the	flip	tool	from	

the toolbox, click inside the canvas. Controls in the Tool Options dockable let you switch between Horizontal and 

Vertical modes.

ALPhA ChANNEL
Alpha channel is used for transparency. Transparency means that when you export to “png”, the transparent parts 

of your image will show whatever is underneath. This is very useful for apps icons or images for web design. When 

your layer does not have an alpha channel, its name should be bolded.

In graphics, a portion of each pixel’s data that is reserved for transparency information. 32-bit graphics systems 

contain	four	channels	—	three	8-bit	channels	for	red,	green,	and	blue	(RGB)	and	one	8-bit	alpha	channel.	The	

alpha channel is really a mask. It specifies how the pixel’s colors should be merged with another pixel when the 

two are overlaid, one on top of the other.

Filters Menu:
The Filters menu includes the following submenus, which group plug-ins by function:

•	 Distorts:	Creates	the	kinds	of	effects	you’d	find	in	a	hall	of	mirrors.	Some	of	these	filters	are	great	for	adding	

special effects to an image, like making ripples in a water surface. If you want to create textures, you’ll find 

many useful filters here.

FLIPPINg AN  
IMAgE(TRANSFoRM TooL)8Chapte

r
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•	 Blur:	Includes	many	different	types	of	blur	filters.	Blurring	is	useful	when	you	want	to	soften	part	of	a	picture.	

Real shadows are seldom hard and solid, so to create realistic shadows you’ll want to soften them up with an 

appropriate blur filter. 

Activity 1:

This	exercise	helps	us	to	flip	an	image.

Steps to follow:

Step 1: Load your image, right click the image in the Layers Channel dialog box and select the option ‘Add Alpha 

channel’.

Step 2: Go to   Filters --> distorts --> Whirl and pinch.

In the Whirl and Pinch dialog box, change the whirl angle to zero, Pinch amount to -0.304, Radius to 1.185.(The 

pinch and radius could be different than what is here as depends on your image.)

 
“Whirl and Pinch” distorts your image in a concentric 
way. 
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Step 3: Go to FiltersDistortsApply Lens. When the menu appears, leave at the default settings and click ‘oK’.

 
Apply Lens - A part of the active 
layer is rendered as through a 
spherical lens. 
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Step 4: Select the Scale tool from the tool box and drag the handles until you get the size needed and then click 

Scale button. 
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Step 5: Right click the image in the layers channel, scroll down and click ‘Alpha to Selection’. Make a new Layer 

by clicking the icon at the bottom of the layer dialog box. Leave at the default and click ‘oK’. This new layer has 

the copy of ‘Alpha Selection’.  Go to ‘Filters’ and choose ‘Blur’, select ‘Gaussian Blur’ and blur to pixelize, then 

click ‘oK’.
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Step 6: Move over to the layers channel, right click the new layer and click ‘Merge Down’ option. Now duplicate 

the layer.
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Step 7:	Select	the	Flip	tool	from	the	tool	box,	click	the	option	flip	‘Vertical’	in	the	tools	option	dialog	box	and	

then	click	on	the	picture.	The	picture	is	now	flipped.	Select	the	‘Move’	tool	and	move	the	Flipped	Layer,	next	to	

the original picture.
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Step 8: Right click the top layer and choose the option ‘Flatten Image’.

 

 Vertical and Horizontal are the two orientations of Flip Tool.

 Alpha Channel is used for Transparency.

 The Filters menu includes the following submenus: Distorts, Blur etc….

 The shortcut key to activate Flip tool is Shift + F key combination.

 When your layer does not have an alpha channel, its name should be bolded.

 The Flatten Image command merges all of the layers of the image into a single layer with no 
alpha channel.Re

cap
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 BRAIN dEVELoPER 

I) FILL IN ThE BLANKS:
1) Blur is an option under _________.

2) Lens effect is available under Filters-________-Lens.

3) Turnover in GIMP is ____________.

4) Vertical and Horizontal are the two orientations of __________.

5) ____________channel is used for transparency.

   Distorts    Flip tool  
   Alpha    Flipping  
   Filters

Teacher’s Signature
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LEARNINg oBjECTIVES
•	 Introduction	to	sharpening	and	softening.

•	 Introduction	to	colors	tool.

•	 Features	of	Colorize	tool,	Brightness-Contrast	tool,	Levels	and	Curves	tool.

•	 Usage	of	Bucket	fill	tool	and	Ellipse	tool.

INTRoduCTIoN  
One of the most common uses of GIMP is to fix digital camera images that for some reason are less than perfect. 

Maybe the image is overexposed or underexposed; maybe rotated a bit; maybe out of focus: these are all common 

problems for which GIMP has good tools.

Graphics programs can be used to both sharpen and blur images in a number of ways. Edge enhancement is an 

extremely common technique used to make images appear sharper.

Another form of image sharpening involves a form of contrast. This is done by finding the average color of the pixels 

around each pixel in a specified radius, and then contrasting that pixel from that average color. This effect makes 

the image seem clearer, seemingly adding details. It is widely used in the printing and photographic industries for 

increasing the local contrasts and sharpening the images. Out-of-focus photographs and most digitized images 

often need a sharpness correction.

GIMP gives you a variety of tools to correct colors in an image, ranging to automated tools that run with a simple 

button-click to highly sophisticated tools that give you many parameters of control. GIMP gives you several 

automated color correction tools.

CoLoR TooLS9Chapte
r

Some imaging devices like digital cameras or scanners offer to sharpen the created 

images for you. We strongly recommend you disable the sharpening in this device 

and use the GIMP filters instead. This way you regain the full control over the 

sharpening of your images.
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CoLoR TooLS
Color tools, which alter the distribution of colors across the entire image. The first part of the Color menu deals 

with how image pixels are mapped to different RGB values; the second part deals with color correction; and the 

third part contains useful filters for auto-correction of scanned photos.

Figure: The Color tools in the Tools menu

With the Color tools you can manipulate image colors in several ways:

• Modify the color balance

• Adjust hue, saturation and lightness levels

• Render into a grey scale image seen through a colored glass

• Adjust brightness and contrast levels

• Transform into a black and white image depending on pixel value

• Change the intensity range in a channel

• Change color, brightness, contrast or transparency in a sophisticated way

The color of images can be altered in a variety of ways. Colors can be faded in and out, and tones can be changed 

using curves or other tools.

Colorize Tool:
The Colorize tool renders the active layer or selection into a grayscale image seen through a colored glass. 

Activating the tool: Colors Colorize…

Color values:
•	 hue: The slider and the numeric input box allow you to select a hue value normalized in the range: 0.0 to 1.0.

•	 Saturation: The slider and the numeric input box allows you to select a saturation value normalized in the 

range: 0.0 to 1.0. 

•	 Lightness: The slider and the numeric box allow you to select a lightness normalized value in the range: -1.0 

(dark) to +1.0 (light).

•	  Preview: The Preview option enable rendering of all changes immediately on canvas.
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Brightness-Contrast Tool:
 The Brightness-Contrast tool adjusts the brightness and contrast levels for the active layer or selection. This tool 

is easy to use, but relatively unsophisticated. The Levels and Curve tools allow you to make the same types of 

adjustments, but also give you the ability to treat bright colors differently from darker colors.

Activating the Tool : Colors Brightness-Contrast….

Curves Tool  
The Curves tool is the most sophisticated tool for changing the color, brightness, contrast or transparency of the 

active layer or a selection. While the Levels tool allows you to work on Shadows and Highlights, the Curves tool 

allows you to work on any tonal range. It works on RGB images. A very powerful way of correcting exposure 

problems is to use the Curves tool.

Activating the Tool

You can get to this tool in two ways:

•	 Colors	Curves….  (or) By clicking on the tool icon   in Toolbox.

Levels Tool:
The Levels tool provides features similar to the Histogram dialog but can also change the intensity range of the 

active layer or selection in every channel. This tool is used to make an image lighter or darker, to change contrast 

or to correct a predominant color cast. 

Activating the Tool: Colors  Levels….

ACTIVITY 1

This exercise helps us to view an image with vignette effect.

Steps to follow

Step 1: Load your image into GIMP.
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Step 2: Go to layer and click New layer (Transparency). Click the Ellipse tool and drag an ellipse around your 

image.

Step 3: Go to Select and click Invert option.

Step 4: Select the Bucket tool. You can choose foreground color as white or Click ‘Pattern fill’ Radio button and 

choose your pattern. Fill the background of your photo.
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Step 5: Go to Select menu and choose ‘None’ option to ‘turn off ’ the selection. Then right click the top layer and 

choose the option ‘Flatten Image’.
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Step 6: Click the ‘Ellipse’ tool and drag an ellipse around your image.

Step 7: Go to ‘Colors’ and click ‘Colorize’ option, adjust the settings according to your picture and then click 

oK button.
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Step 8: Go to FiltersEnhanceunsharp Mask. Now adjust the settings according to your picture and then 

click oK button.

The Unsharp Mask filter sharpens edges of the elements without increasing noise or blemish.  

It is the king of the sharpen filters.
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Step 9: Go to select and click Invert option (to select the back ground). 

Now you can choose any one of the following steps to change the background color of the image.

9a)  Go to ColorsBrightness- Contrast, adjust the settings according to your picture and then click oK button.

9b)  Go to ColorsLevels, adjust the settings according to your picture and then click oK button.
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9c)  Go to ColorsCurves, adjust the settings according to your picture and then click ok button.   

The final Vignette Effect after sharpening the picture ……………

Re
cap
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Re
cap

•	 Graphics	programs	can	be	used	to	both	sharpen	and	blur	images	in	a	number	of	
ways. 

•	 A	color	tool	helps	to	manipulate	image	colors.
•	 Colors	can	be	faded	in	and	out,	and	tones	can	be	changed	using	curves	or	other	

tools.
•	 Color	tools:	Colorize,	Brightness-Contrast,	Levels	and	Curves.
•	 Selection			tools	like	ellipse	tool	are	used	to	select	a	portion	of	the	image.
•	 The	Invert	command	inverts	the	selection	in	the	current	layer.
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 BRAIN dEVELoPER 

I) ChooSE ThE CoRRECT ANSWER:

1. None option from the Select menu is chosen to (Turn on / Turn off ) the selection.

2. Curve option is (available / not available) in Colors menu.

3.  is a (curve / color ) tool in GIMP.

4. Color, Contrast and Brightness of an image can be altered using (color/curve) tool.

5. Colors can be faded in and out, and tones can be changed using (Curve/ Selection) tools.

Teacher’s Signature
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LEARNINg oBjECTIVES
•	 Layer	modes	in	GIMP

•	 Normal	mode	and	Doge	mode

•	 Filter	effects

•	 Color	images

INTRoduCTIoN

Layer Modes
Layer modes are also sometimes called “blending modes”. Blending Modes or Transfer Modes control how the 

pixels in a foreground layer blend into the background layer(s). GIMP has twenty-one layer modes. Selecting a 

layer mode changes the appearance of the layer or image, based on the layer or layers beneath it. If there is only one 

layer, the layer mode has no effect. There must therefore be at least two layers in the image to be able to use layer 

modes. Modes are mainly used with layers, but they can also be used more directly as Paint Modes with the Bucket 

tool, the Blend tool or any tool that uses Brush Selection.

You can set the layer mode in the Mode menu in the Layers dialog. GIMP uses the layer mode to determine how 

to combine each pixel in the top layer with the pixel in the same location in the layer below it.

Layer modes permit complex color changes in the image. They are often used with a new layer which acts as a 

kind of mask. For example, if you put a solid white layer over an image and set the layer mode of the new layer to 

“Saturation”, the underlying visible layers will appear in shades of gray.

Since the results of each mode vary greatly depending upon the colors on the layers, these images can only give 

you a general idea of how the modes work. You are encouraged to try them out yourself. You might start with two 

similar layers, where one is a copy of the other, but slightly modified (by being blurred, moved, rotated, scaled, 

color-inverted, etc.) and seeing what happens with the layer modes.

hANd SKETCh  
EFFECT(LAyER ModES)10Ch
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Note

There is a drop-down list in the Toolbox options box which contains modes that affect the painting tools in a 
similar way to the layer modes. You can use all of the same modes for painting that are available for layers, and there 
are two additional modes just for the painting tools.
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Some of the Layer modes are:

•	 Normal mode is the default layer mode. The layer on top covers the layers below it. If you want to see anything 

below the top layer when you use this mode, the layer must have some transparent areas.

•	 dodge mode multiplies the pixel value of the lower layer by 256, then divides that by the inverse of the pixel 

value of the top layer. The resulting image is usually lighter, but some colors may be inverted.

In photography, dodging is a technique used in a darkroom to decrease the exposure in particular areas of the 

image. This brings out details in the shadows. When used for this purpose, dodge may work best on Grayscale 

images and with a painting tool, rather than as a layer mode.

Filter Command
A Filter is a special kind of tool designed to take an input layer or image, apply a mathematical algorithm to it, and 

return the input layer or image in a modified format. GIMP uses filters to achieve a variety of effects and “Distort 

Filters” effects are applied here. 

The other filters effects like  “Blur Filters”, “Enhance Filters”, “Light and Shadow Filters”, “Noise Filters” ,“Edge-

Detect Filters”, “Generic Filters” ,“Combine Filters” ,“Decor Filters”, “Artistic Filters”  can be applied.

Activity 1:

This exercise helps us to turn a photo into hand sketch drawing using GIMP. 

Firstly, duplicate the layer then change its blend mode from normal to Dodge. Invert the picture’s color by going 

to Colors-->Invert command. The next step is applying value propagate filter for two or three times until you get 

the desired effect of hand sketch. Let’s get started:

Steps to follow

Step 1: Load your image into GIMP.
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Step 2: Duplicate the layer by going to Layer==>Duplicate Layer command. Change its Layer blend mode from 

Normal to Dodge mode.
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Step 3: Go to Colors==>Invert to invert the picture’s color.

 
The color of images can be manipulated 
with the help of Color options in several 
ways. 
 

Step 4: The final step is to apply Value Propagate from filter menu. Go to Filters==>distorts>Value Propagate 

command in the top menu. In the “Value Propagate” pop-up window, select the “More black (smaller value)” radio 

button by clicking on it. Click OK when you are done.
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Value Propagate : This filter works on 
color borders. It spreads pixels that differ 
in a specified way from their neighboring 
pixels. 

Turn’s a photo into a sketch using GIMP.
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Step 5: If you’d like a black & white sketch effect, then apply desaturate for both layers by going to 

Colors==>desaturate command.

 
Desaturation makes colors more 
muted (more black or white added). 

The final output of Black& White version sketch effect.

 

Re
cap
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Re
cap •		 GIMP	has	twenty-one	layer	modes.	Layer	modes	are	also	sometimes	called	“blending	modes”.

•	 Normal	mode	is	the	default	layer	mode.

•	 The	color	of	images	can	be	manipulated	with	the	help	of	Color	options	in	several	ways.

•	 A	Filter	is	a	special	kind	of	tool	designed	to	take	an	input	layer	or	image,	apply	a	mathematical	
algorithm to it, and return the input layer or image in a modified format.

 BRAIN dEVELoPER 

I) FILL IN ThE BLANKS WITh ThE hELP oF hINTS gIVEN BELoW:

1. Layer modes are also sometimes called  ______________ modes.

2. GIMP uses the ________ mode to determine how to combine each pixel in the top layer with the pixel in the 

same location in the layer below it.

3.  “Distort ”  is one of the option in  ______________  menu .

4. ______________mode is the default layer mode.

5. In _______________ mode the resulting image is usually lighter, but some colors may be inverted.

6. To invert the picture’s color, go to Colors==>__________ option .

7.   GIMP has ______________ layer modes.

Teacher’s Signature

• Invert • 21 • Normal • Blending  

• Layer • Dodge • Filters

Hints



148

PAgECuRL EFFECT  
(FREE SELECT TooL)11Ch

ap
te

r

LEARNINg oBjECTIVES
•	 Introduction	to	selection	tools.

•	 Usage	of	Free	Select/Lasso	tool,	Scale	tool.

•	 Knowing	the	built	in	filter	of	GIMP.

•	 Knowing	about	Filter	options.

INTRoduCTIoN
Selection tools are designed to select regions from the active layer so you can work on them without affecting the 

unselected areas. Each tool has its own individual properties, but the selection tools also share a number of options 

and features in common. Now, we will discuss one of the selection tool named “Free Select tool “.

Free Select Tool  
The Free Select tool or Lasso tool lets you create a selection by drawing it with the pointer.

In GIMP-2.8, you can use it in two ways. First create the starting point clicking on your image. Then,

•	 Maintaining	the	mouse	button	pressed	(	i.e	click-and-drag),	drag	to	draw	a	free	hand	selection.	When	end	point	

comes superimposed on the starting point, release the mouse button to close the selection. If you click on the 

end point, it turns accompanied by a moving cross. Then, dragging enlarges the shape.

•	 Or	release	the	mouse	button	and	drag	to	draw	a	polygonal	selection.	When	end	point	comes	superimposed	on	

the starting point, click to close the selection.

Activating the tool

You can access the Lasso Tool/ Free Select Tool in different ways:

•	 Tools	 Selection Tools Free Select Tool (or)

•	 By	clicking	on	the	tool	icon	  in the Tool Box (or)

•	 By	using	the	keyboard	shortcut	F.

Filters - Page curl
This filter curls a corner of the current layer or selection into a kind of cornet showing the underlying layer in the 

cleared area. A new “Curl Layer” and a new Alpha channel are created. The part of the initial layer corresponding 

to this cleared area is also transparent.

In GIMP 2.10 
Free  

Select Tool is 
named as Lasso 

Tool
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GIMP has a built-in filter to make a Page Curl.  You can adjust the Page Curl effect using 

Scale tool and Selection tool.

Activity 1

In this exercise, we create a Page Curl effect using selection and transform tools.

Steps to follow:

Step 1: Load your image into GIMP, right click the image in the layer dialog box and choose ‘Add Alpha channel’. 

Duplicate the layer by clicking the ‘Duplicate’ icon at the bottom of the dialog box.

 
Add Alpha Channel: An alpha 
channel is automatically added into 
the Channel Dialog as soon as you 
add a second layer to your image. It 
represents the transparency of the 
image. 

Step 2: Go to Filters -> distorts ->Page curl.

 

Cornet - a 
paper folding 
like a cone. 
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Step 3: Click the oK button.

Step 4:  The Page curl effect is applied.
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Step 5: You get a very big Page curl which is unsuitable for most of the images.  

The page curl filter makes a top transparency layer in order to re-scale it.

Select ‘Scale tool’ and drag the handles until you get the size needed. Go to the center of the scale and drag the 

new size curl to the bottom corner then click Scale.
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Step 6: In the layers dialog box, right click the top layer and choose ‘Merge Visible layer’ option.

Step 7: Select ‘Lasso tool/Free select tool’  and click in the top corner and drag a selection to where the curve 

starts. When you reach the bottom, click the Mouse button and move to the right bottom corner, click and return 

to the start point.  This will make a selection.
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Step 8: Go to Edit menu and choose cut (or) press the delete key from the keyboard, the selection is removed. Save 

your image as a ‘scenery.png’ file.
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 Page curl effect looks like a cornet.

 Size and Location of the Curl can vary.

 Lasso Tool is also called as Free Select Tool.

 By default the curl is at the lower right corner.

 Scale tool is one of the Transform Tool.

 BRAIN dEVELoPER 

I) FILL IN ThE BLANKS WITh ThE hELP oF hINTS gIVEN BELoW:

1.  Lasso tool is also called as ________ Tool.

2.  The page curl filter makes a top transparency layer in order to _______ it.

3.  Page Curl can be chosen from ______-distorts- Page curl.

4.      is a ___________ tool.

5.   Ctrl +C is the short cut key to ______ an image.

Teacher’s Signature
  Free select
  Copy
  Lasso 
  Filters
  Rescale

Hints
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ShARPENINg AN IMAgE 
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LEARNINg oBjECTIVES
•	 Introduction	to	sharpening.

•	 Usage	of	Foreground	Select	Tool.

•	 How	to	Sharpen	and	Blur	an	Image

INTRoduCTIoN
Sharpening the digital photos using an image editor on a computer is simple but can make a photo appear more crisp 

and appealing. A dedicated photo editor (like GIMP) on the computer can usually do a better job at sharpening 

photos.

Quick and simple sharpening

A “Sharpness” setting of between 10 and 50 is usually adequate.

Sharpening a snapshot in GIMP is quick and easy: Simply select the Filters > Enhance > Sharpen command 
from the main menu. A “Sharpen” dialog box pops up showing a single “Sharpness” slider to control the amount 
of sharpening to be applied, and a thumbnail to preview the effect visually. Enlarge the dialog box to make the 
preview thumbnail bigger.
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The Sharpen command reduces the amount of blur or fuzziness around the edge of a selection. It reverses the effect 
of the Feather Selection command. The new edge of the selection follows the dotted line of the edge of the old 
selection. Anti-aliasing is also removed.

Avoid setting the sharpness amount too high; since this will also sharpen the undesirable noise and grain in the 
photo and make the photo look garish.

Foreground Select Tool   

The foreground select tool is one of the selection tools. This tool lets you extract the foreground from the active 
layer or from a selection. After the selection is made, with its marching ants, you can copy-paste or click-and-drag 
it to another image used as background, and, inverting the selection; you can make changes in background.

You can activate the Foreground Select tool in two ways:

•	 By	clicking	on	the	tool	icon	  in the Toolbox

(or)

•	 Tools	 Selection Tools  Foreground Select Tool.

Figure: The foreground Select Tool in the Tool Box:

Activity 1

In this exercise we will use the “Foreground Select tool”, shown 

in the Toolbox on the left. When you select this tool, the mouse pointer goes with the Lasso icon. It actually works 
like the Fuzzy Select tool. Select as little as possible from the background. When you return to the starting point 
the rough selection remains the same but the background turns into a dark blue color. Move your cursor to the 
center	of	the	flower	(which	has	now	auto	selected	the	paintbrush)	hold	the	mouse	button	down	and	paint	part	of	
the	flower,	when	you	release	the	mouse	button.

GIMP	auto	selects	the	flower.	Press	enter,	to	complete	the	selection	and	then	sharpen	the	picture.	The	selected	
portion color can be changed using the color adjust curves. The steps are given below…
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Steps to Follow:

Step 1: Load your image into GIMP.

Step 2: Go to Layers on the Menu bar and select Duplicate layer (or) Right click the top layer and select Duplicate 
layer. Select the Foreground select tool from the tool box, the mouse pointer becomes like a lasso icon, draw around 
your	flower	and	only	release	the	mouse	button	when	you	return	to	the	start	point.

Step 3: When selection is completed, the cursor auto changes to the paint brush, color is not important but the 
default	is	black,	paint	on	the	flower	and	cover	any	color	change	on	the	flower.	Once	you	release	the	mouse	button	
GIMP makes a selection. Now press the enter key to complete the selection.
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The picture is now selected …..
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\

Step 4: From the Filters menu, choose ‘Enhance’ and ‘Sharpen’ option.
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The picture is sharpened…..

Step 5: From the Colors menu, choose Curves and then adjust color curves of your choice.
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•	 “Foreground	Select	tool”	actually	works	like	the	Fuzzy	Select	tool.

•	 Colors	can	be	faded	in	and	out,	and	tones	can	be	changed	using	curves	or	other	tools.

•	 Most	of	digitized	images	need	correction	of	sharpness.

•	 Both	blurring	and	sharpening	work	incrementally:	moving	the	brush	repeatedly	over	an	
area will increase the effect with each additional pass. The Rate control allows you to 
determine how quickly the modifications accumulate. The Opacity control, however, can 
be used to limit the amount of blurring that can be produced by a single brushstroke, 
regardless of how many passes are made with it.

 BRAIN dEVELoPER 

I) FILL IN ThE BLANKS WITh ThE hELP oF hINTS gIVEN BELoW:

1. GIMP is a dedicated ________ editor.

2. Sharpening and Softening are the two features of _________.

3. Too high Sharpness will make the image ____________.

4. Tools__________-->Foreground select.

5.  Blur is the opposite of ________.

Teacher’s Signature

  Image
  Select
  Sharp
  Garish
  Editing

Hints
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LEARNINg oBjECTIVES
•	 Introduction	to	Perspective	Tool.

•	 To	enhance	an	Image	with	different	outlook.

•	 To	attach	(Anchor)	different	Layers.

•	 How	to	coordinate	with	different	Tools.

•	 Familiarization	of	Edit	menus.

INTRoduCTIoN

Perspective Tool   
This tool is one of the Transform tools. The Perspective Tool   is used to change the “perspective” of the active 

layer content, of selection content. When you click on the image, according to the Preview type you have selected, 

a rectangular frame or a grid pops up around the selection (or around the whole layer if there is no selection), with 

a handle on each of the four corners. By moving these handles by click-and-drag, you can modify the perspective. 

At the same time, a “Transformation information” pops up, this lets you valid the transformation. At the center of 

the element, a circle lets you move the element by click-and-drag.

Figure: The perspective tool in the tool box
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Activating the Perspective Tool

You can access the Perspective tool in different ways:

•	 Tools->	Transform	Tools->	Perspective	Tool	(or)

•	 By	clicking	the	tool	icon:  in Toolbox (or)

•	 By	using	the	Shift + P key combination.

Float command:
The Float	command	converts	a	normal	selection	into	a	“floating	selection”.	A	floating	selection	(sometimes	called	

a	“floating	layer”)	is	a	type	of	temporary	layer	which	is	similar	in	function	to	a	normal	layer,	except	that	before	

you	can	resume	working	on	any	other	layers	in	the	image,	a	floating	selection	must	be	anchored. That is, you have 

to	attach	it	to	a	normal	(non-floating)	layer,	usually	the	original	layer	(the	one	which	was	active	previously),	for	

instance,	by	clicking	on	the	image	outside	of	the	floating	selection.

You	can	use	various	operations	to	change	the	image	data	on	the	floating	selection.	There	can	only	be	one	floating	

selection in an image at a time.

Activity 1

This exercise helps us to create a ‘3D POP OUT EFFECT’ using Perspective tool, Selection tool and Blend tool.

Steps to Follow:

Step 1: Load your image into GIMP.

Step 2:  Create a new layer and make sure the new layer is Transparency. Select the Rectangle tool and drag a 

selection over the car as shown below.
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Step 3: Select the ‘Bucket tool’ from the tool box, change the foreground color to white and fill the selection.

Step 4: Go to the select menu and choose Shrink option. Depending on the size of the image shrink the number 
of pixelize and then click ok.

The Shrink command reduces the size of the selected area by moving each point on the edge of the selection a 
certain distance further away from the nearest edge of the image (toward the center of the selection). Feathering is 
preserved, but the shape of the feathering may be altered at the corners or at points of sharp curvature.
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Step 5: Now click the Edit menu and choose Cut option.

Step 6: Again, using the Rectangle tool, draw a selection around outside of the white frame. Now click the 
Perspective tool from the tool box, then move to the bottom right corner and drag the white border to an angle that 
shows image within the frame (adjusting the white border). Do the same on the top right hand corner.
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Step 7: The	Perspective	tool	creates	a	floating	layer.		Click	the	‘Anchor’	icon	at	the	bottom	of	the	layer	dialog	box	
to lock it to the layer below.
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Step 8: In ‘layers’ move the opacity slider to about 70% transparency. Select the Eraser tool from the tool box, 

change the foreground color to white and erase the section on the white frame over the car body. When completed, 

return the opacity back to 100%.
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Step 9: Go to the layer menu and choose the ‘Merge Down’ option. Using Lasso tool/Free select tool, select the 
outer area of the frame and car.

The Merge Down command merges the active layer with the layer just below it in 
the stack, taking into account the various properties of the active layer,  

such as its opacity and layer.
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Step 10: From	the	Select	menu,	choose	Invert	option.		This	flips	the	selection	to	the	outer	area	of	the	frame	and	car.

Step 11: From the Edit menu, choose Cut option. This removes the outer selection from the image. The Selection 
is still active. Go to Select menu and choose None option.

Step 12: Now, Create a new layer and make sure it is transparency and move the layer down using the Green down 

arrow at the bottom of the dialog box.
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Step 13: Using the Blend tool, drag the mouse over your image from one corner to the other corner by choosing a 

color of your choice. Finally, select the top layer, then click the layer menu and choose the ‘Merge Down’ option.

This is the final ‘3d Pop out effect’.

☛ The Perspective Tool   is used to change the “perspective” of the active layer content, 
of selection content.

☛ The Float command converts a normal selection into a “floating selection”.

☛ You cannot perform any operations on other layers while the image has a floating 
selection.

☛ If there is an active selection tool, the mouse pointer is displayed with an anchor icon 
when it is outside of the selection.

☛ There can only be one floating selection in an image at a time.
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 BRAIN dEVELoPER 

I) ChooSE ThE CoRRECT ANSWER:

1.  is a  (Selection Tool / Perspective Tool ).

2. Perspective means  (Outfit / Outlook ) of an Image.

3. (Shift +P / Shift +O ) is the short cut key for Perspective Tool.

4. The Floating Selection can also be called as (Floating Layer / Floating Image).

5. Anchor is to (Attach / Detach) the layers.

Teacher’s Signature
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INRoduCTIoN  
To hARdWARE14Ch

ap
te

r

LEARNINg oBjECTIVES
•	 Introduction	to	Hardware.

•	 Features	of	Hard	disk.

•	 Features	of	Mother	Board.

INTRoduCTIoN
Computer hardware includes the physical, tangible parts or components of a computer, such as the  cabinet, central 

processing unit, monitor, keyboard, computer data storage, graphics card, sound card, speakers and motherboard. 

By contrast, software is instructions that can be stored and run by hardware. Hardware is typically directed by 

the software to execute any command or instruction. A combination of hardware and software forms a usable 

computing system, although other systems exist with only hardware components.

Internal System unit Components
The Internal System Unit is made up of many components such as the Processor, Motherboard, BIOS, Power 

supply, fan and heat sink, hard drive configuration and controllers e.g. RAM, ROM, Cache and specialized cards 

e.g. Network and graphic cards.

Processor
The processor is also known as the CPU which stands for Central Processing Unit and the Heart of the computer 

system which controls everything.

CPU BOARD
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hard disks
Hard disks are used to store data in a non-volatile form within the machine. i.e. the data remains intact even if the 

power to the device is cut off. Data is stored as magnetic ones and zeros on a steel platen and is read by pickup arms 

that scan the drive as the platens spin.

different Ports:  The functions of ports are to allow peripheral devices to connect to the computer. There are a 

variety of ports that are found on the back of the system unit in order to connect a range of peripherals to connect 

to the processor. Two types of Ports can be found on the system unit: Serial Port and a Parallel Port.

•	 Serial	Port:		is	an	interface	that	can	be	used	for	serial	communication.	A	Serial	port	only	transmits	1	bit	at	a	

time and the cable is usually circular.

•	 Parallel	Port:	Parallel	Port	allows	 the	user	 to	use	devices	 side	by	side.	Printers,	USBs	are	all	examples	of	

peripherals that use Parallel Ports.

These ports are used to transfer data from a peripheral device to the computer. Serial communication is done 

through a transmitter which then sends data to a receiver using a single communication. These types of methods 

are really suitable for transferring or sending and receiving data over a long distance.
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Motherboard:

The most important part of any computer is the motherboard. As the name implies a motherboard is the mother 

of all other components in a computer.

The motherboard brings all the core components together such as the Central Processing Unit (CPU), Memory 

and Hard Disks. In short, the motherboard connects and allows all of the components in the computer to work 

together.

•	 Computer	hardware	includes	the	physical,	tangible	parts	or	components	of	a	computer,	such	as	the		cabinet,	
central processing unit, monitor, keyboard, computer data storage, graphics card, sound card, speakers and 
motherboard.

•	 The	Internal	System	Unit	is	made	up	of	many	components	such	as	the	Processor,	Motherboard	and	hard	drive	
etc…

•	 Two	types	of	Ports	can	be	found	on	the	system	unit:	Serial	Port	and	a	Parallel	Port.

•	 The	motherboard	connects	and	allows	all	of	the	components	in	the	computer	to	work	together.
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IT SCHOOL@
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User Skill  

Typing Tutor
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TyPINg TuToR  
INTRoduCTIoN

 The knowledge of touch typing has become inevitable today in the use of computers.

 With typing tutor, you can learn touch typing in an easier and simple way.

 It is very similar to you that there are 26 letters in English alphabet. All these 26 letters are presented in the 
computer keyboard too.

 But, 26 letters are not arranged in an alphabetical order.

 The letters in the keyboard is arranged in QWERTY order.

TyPINg STEPS

Follow the steps below:-

Step 1: First of all place your hand on the keyboard.

Step 2: Place your

 Little finger of your left hand gently on the ‘A’

 Ring finger on ‘ S ’

 Middle finger on ‘ D ’

 Index finger for both ‘ F ’ and ‘ G ’

Step 3: Place your

 Little finger of your right hand gently  
on the key semicolon ‘ ; ’

 Ring finger on ‘ L ’

 Middle finger on ‘ K ‘

 Index finger for both ‘ H ’ and ‘ J ’
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Step 4: Place both your left and right thumbs on the spacebar key.

Lets start typing. Whatever it may be letter or numbers all most all the keys you can see around your fingers.

LEFT hANd FINgER
Name of the Finger Keys on the Keyboard

Little Finger A

Ring Finger S

Middle Finger D

Index Finger F,G

Thumb Spacebar

RIghT hANd FINgER
Name of the Finger Keys on the Keyboard

Little Finger ;
Ring Finger L
Middle Finger K
Index Finger J,H
Thumb Spacebar

ThE QWERTy LAyouT

The keys on the keyboard is arranged in QWERTY layout. The layout is referred to us as “QWERTY” because of 

the arrangement of the keys in the upper row is QWERTY.
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hoME RoW

The finger of an experienced typist never “rest” However, if we could ask the fingers where they spend most of their 

time, it is over the home row.

When you are still learning to access keyboard, be careful to keep at least one finger of each hand anchored over 

the home row.  

uPPER RoW / QWERTy RoW

QWERTY Row is located just above the Home row. It contains many number of characters.

LoWER RoW

Lower Row is located just below the home row, contains limited number of keys.

NuMBERS RoW

Numbers Row is located above the upper row, number keys are also available in a separate place at the right side 

of the keyboard.

ANChoRINg

Anchoring means to keep a finger in very light contact with its home row key.

During the early stages of learning keyboard, this is necessary for the brain to develop a sense of position for the 

hands and fingers.

As you become a more skilled typist, your fingers will automatically move to the correct position of the keys.
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